SMART-AG User Manual

Publication Number: OM-20000123
Revision Level: 4
Revision Date: 2009/12/17
Firmware Version: 3.710, SMART-AG application 1.100

Proprietary Notice

Information in this document is subject to change without notice and does not represent a commitment on the part of NovAtel Inc. The software described in this document is furnished under a licence agreement or non-disclosure agreement. The software may be used or copied only in accordance with the terms of the agreement. It is against the law to copy the software on any medium except as specifically allowed in the license or non-disclosure agreement.

No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose without the express written permission of a duly authorized representative of NovAtel Inc.

The information contained within this manual is believed to be true and correct at the time of publication.

Advance, NovAtel, Narrow Correlator tracking technology, OEMV, ProPak, and RT-2, RT-20 are registered trademarks of NovAtel Inc.

PAC, and SMART-AG are trademarks of NovAtel Inc.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such marks by NovAtel Inc. is under license. All other brand names are trademarks of their respective holders.

Manufactured and protected under U.S. Patent:

- **PAC Correlator**
  - #6,243,409 B1
  - #5,414,729

- **Narrow Correlator**
  - #5,101,416
  - #5,390,207
  - #5,495,499
  - #5,809,064

- **GLONASS**
  - #6,608,998 B1

- **GALILEO**
  - #6,184,822 B1

- **Dual Frequency GPS**
  - #5,736,961

- **Position for Velocity Kalman Filter**
  - #6,664,923 B1

- **Anti-Jamming Technology**
  - #5,734,674

- **RTK Positioning**
  - #6,728,637 B2
  - #6,664,923 B1

© Copyright 2009 NovAtel Inc. All rights reserved. Unpublished rights reserved under International copyright laws. Printed in Canada on recycled paper. Recyclable.
# Table of Contents

4.3.1 Rinex Format .............................................................................................. 45  
4.3.2 Convert4 Command Line Switches............................................................. 47  
4.4 Firmware Upgrades .............................................................................................. 48  
4.4.1 Upgrading Using the AUTH Command....................................................... 48  
4.4.2 Updating Using the WinLoad Utility ............................................................ 49  

5 Bluetooth® Configuration ................................................................................. 54  
5.1 Bluetooth on the SMART-AG Receiver ........................................................ 54  
5.2 Set Up a PC/Laptop with a Bluetooth Adaptor ............................................... 54  
5.3 Locate a Bluetooth-Enabled SMART-AG in Range ....................................... 55  
5.4 Communicate with the SMART-AG Using Bluetooth ................................. 56  
5.5 Stop Communicating with the SMART-AG Using Bluetooth ......................... 57  

A Technical Specifications ................................................................................ 59  
SMART-AG Receiver Performance ..................................................................... 59  
SMART-AG Specifications ................................................................................. 60  

B Commands ...................................................................................................... 66  
Syntax Conventions ............................................................................................. 66  
COM Configure COM Port .................................................................................. 67  
FRESET Clear Selected Data from NVM and Reset ........................................... 70  
LOG Request Logs from the Receiver ................................................................. 72  
$PMDT Configure Tilt Compensation ............................................................. 77  
RADARCFG Configure the ER Output ............................................................... 78  

C Logs ............................................................................................................... 80  
Position Logs .................................................................................................... 80  
Other Logs ....................................................................................................... 82  

D Replacement Parts ......................................................................................... 87  
SMART-AG ......................................................................................................... 87  
Accessories ..................................................................................................... 87
Tables

1. SMART-AG Controller Models ................................................................. 19
2. SMART-AG Connector Pin-Out ............................................................... 21
3. SMART-AG LED Status Indicators ....................................................... 24
4. Available CAN Signals on the SMART-AG ........................................ 26
5. NovAtel Logs for Rinex Conversion .................................................... 47
6. SMART-AG Development Kit Cable Pinouts ....................................... 63
7. SMART-AG Mating Connectors ............................................................ 64
8. Recommended Fuse and Fuse Holders .................................................. 65
9. SMART-AG Commands in Alphabetical Order ................................... 66
10. COM Serial Port Identifiers ................................................................. 68
11. Parity ................................................................................................. 68
12. Handshaking ....................................................................................... 68
13. FRESET Target ................................................................................... 70
14. Detailed Serial Port Identifiers ............................................................ 75
15. Response Modes ................................................................................ 79
16. SMART-AG Logs in Alphabetical Order ........................................... 82
17. Position or Velocity Type .................................................................... 84
18. Solution Status .................................................................................. 85
19. Component Type ................................................................................ 86
<table>
<thead>
<tr>
<th>Figures</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. SMART-AG Receiver</td>
<td>18</td>
</tr>
<tr>
<td>2. SMART-AG Connector</td>
<td>20</td>
</tr>
<tr>
<td>3. Simplified SMART-AG Setup</td>
<td>22</td>
</tr>
<tr>
<td>4. OEMV CD</td>
<td>22</td>
</tr>
<tr>
<td>5. SMART-AG Mounting Plate</td>
<td>23</td>
</tr>
<tr>
<td>6. SMART-AG Installation</td>
<td>26</td>
</tr>
<tr>
<td>7. SMART-AG Orientation</td>
<td>27</td>
</tr>
<tr>
<td>8. Open Configuration Window</td>
<td>30</td>
</tr>
<tr>
<td>9. Basic Differential Setup</td>
<td>32</td>
</tr>
<tr>
<td>10. SMART-AG Tilt Compensation</td>
<td>37</td>
</tr>
<tr>
<td>11. Convert4 Screen Examples</td>
<td>45</td>
</tr>
<tr>
<td>12. Convert4 Command Line Arguments</td>
<td>47</td>
</tr>
<tr>
<td>13. Main Screen of WinLoad</td>
<td>50</td>
</tr>
<tr>
<td>14. WinLoad’s Open Dialog</td>
<td>51</td>
</tr>
<tr>
<td>15. Open File in WinLoad</td>
<td>51</td>
</tr>
<tr>
<td>16. COM Port Setup</td>
<td>52</td>
</tr>
<tr>
<td>17. Searching for Card</td>
<td>52</td>
</tr>
<tr>
<td>18. Authorization Code Dialog</td>
<td>52</td>
</tr>
<tr>
<td>19. Upgrade Process Complete</td>
<td>53</td>
</tr>
<tr>
<td>20. Bluetooth Adapter for PC/Laptop</td>
<td>54</td>
</tr>
<tr>
<td>22. Bluetooth Error: Red</td>
<td>54</td>
</tr>
<tr>
<td>23. My Bluetooth Places Window</td>
<td>55</td>
</tr>
<tr>
<td>24. Bluetooth PIN Code Request</td>
<td>56</td>
</tr>
<tr>
<td>25. PC/Laptop COM3 Port Assignment</td>
<td>56</td>
</tr>
<tr>
<td>26. Bluetooth Connected: Green</td>
<td>57</td>
</tr>
<tr>
<td>27. COM3 Disconnect?</td>
<td>57</td>
</tr>
<tr>
<td>28. SMART-AG Development Kit Cable</td>
<td>62</td>
</tr>
</tbody>
</table>
BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE WITH THESE TERMS OF USE, DO NOT INSTALL, COPY OR USE THIS ELECTRONIC PRODUCT (SOFTWARE, FIRMWARE, SCRIPT FILES, OR OTHER ELECTRONIC PRODUCT WHETHER EMBEDDED IN THE HARDWARE, ON A CD OR AVAILABLE ON THE COMPANY WEB SITE) (hereinafter referred to as "Software").

1. License: NovAtel Inc. ("NovAtel") grants you a non-exclusive, non-transferable license (not a sale) to, where the Software will be used on NovAtel supplied hardware or in conjunction with other NovAtel supplied software, use the Software with the product(s) as supplied by NovAtel. You agree not to use the Software for any purpose other than the due exercise of the rights and licences hereby agreed to be granted to you.

2. Copyright: NovAtel owns, or has the right to sublicense, all copyright, trade secret, patent and other proprietary rights in the Software and the Software is protected by national copyright laws, international treaty provisions and all other applicable national laws. You must treat the Software like any other copyrighted material except that you may make one copy of the Software solely for backup or archival purposes (one copy may be made for each piece of NovAtel hardware on which it is installed or where used in conjunction with other NovAtel supplied software), the media of said copy shall bear labels showing all trademark and copyright notices that appear on the original copy. You may not copy the product manual or written materials accompanying the Software. No right is conveyed by this Agreement for the use, directly, indirectly, by implication or otherwise by Licensee of the name of NovAtel, or of any trade names or nomenclature used by NovAtel, or any other words or combinations of words proprietary to NovAtel, in connection with this Agreement, without the prior written consent of NovAtel.

3. Patent Infringement: NovAtel shall not be liable to indemnify the Licensee against any loss sustained by it as the result of any claim made or action brought by any third party for infringement of any letters patent, registered design or like instrument of privilege by reason of the use or application of the Software by the Licensee or any other information supplied or to be supplied to the Licensee pursuant to the terms of this Agreement. NovAtel shall not be bound to take legal proceedings against any third party in respect of any infringement of letters patent, registered design or like instrument of privilege which may now or at any future time be owned by it. However, should NovAtel elect to take such legal proceedings, at NovAtel's request, Licensee shall co-operate reasonably with NovAtel in all legal actions concerning this license of the Software under this Agreement taken against any third party by NovAtel to protect its rights in the Software. NovAtel shall bear all reasonable costs and expenses incurred by Licensee in the course of co-operating with NovAtel in such legal action.

4. Restrictions: You may not:

(a) copy (other than as provided for in paragraph 2), distribute, transfer, rent, lease, lend, sell or sublicense all or any portion of the Software except in the case of sale of the hardware to a third party;
(b) modify or prepare derivative works of the Software;
(c) use the Software in connection with computer-based services business or publicly display
visual output of the Software;
(d) transmit the Software over a network, by telephone or electronically using any means (except when downloading a purchased upgrade from the NovAtel Web site); or
(e) reverse engineer, decompile or disassemble the Software.
You agree to keep confidential and use your best efforts to prevent and protect the contents of the Software from unauthorized disclosure or use.

5. **Term and Termination**: This Agreement and the rights and licences hereby granted shall continue in force in perpetuity unless terminated by NovAtel or Licensee in accordance herewith. In the event that the Licensee shall at any time during the term of this Agreement: i) be in breach of its obligations hereunder where such breach is irremediable or if capable of remedy is not remedied within 30 days of notice from NovAtel requiring its remedy; then and in any event NovAtel may forthwith by notice in writing terminate this Agreement together with the rights and licences hereby granted by NovAtel. Licensee may terminate this Agreement by providing written notice to NovAtel. Upon termination, for any reasons, the Licensee shall promptly, on NovAtel's request, return to NovAtel or at the election of NovAtel destroy all copies of any documents and extracts comprising or containing the Software. The Licensee shall also erase any copies of the Software residing on Licensee's computer equipment. Termination shall be without prejudice to the accrued rights of either party, including payments due to NovAtel. This provision shall survive termination of this Agreement howsoever arising.

6. **Warranty**: NovAtel does not warrant the contents of the Software or that it will be error free. The Software is furnished "AS IS" and without warranty as to the performance or results you may obtain by using the Software. The entire risk as to the results and performance of the Software is assumed by you. See product enclosure, if any for any additional warranty.

7. **Indemnification**: NovAtel shall be under no obligation or liability of any kind (in contract, tort or otherwise and whether directly or indirectly or by way of indemnity contribution or otherwise howsoever) to the Licensee and the Licensee will indemnify and hold NovAtel harmless against all or any loss, damage, actions, costs, claims, demands and other liabilities or any kind whatsoever (direct, consequential, special or otherwise) arising directly or indirectly out of or by reason of the use by the Licensee of the Software whether the same shall arise in consequence of any such infringement, deficiency, inaccuracy, error or other defect therein and whether or not involving negligence on the part of any person.

8. **Disclaimer and Limitation of Liability**:
(a) **THE WARRANTIES IN THIS AGREEMENT REPLACE ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. NovAtel DISCLAIMS AND EXCLUDES ALL OTHER WARRANTIES. IN NO EVENT WILL NovAtel'S LIABILITY OF ANY KIND INCLUDE ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, EVEN IF NovAtel HAS KNOWLEDGE OF THE POTENTIAL LOSS OR DAMAGE.**
(b) NovAtel will not be liable for any loss or damage caused by delay in furnishing the Software or any other performance under this Agreement.
(c) NovAtel's entire liability and your exclusive remedies for our liability of any kind (including liability for negligence) for the Software covered by this Agreement and all other performance or non-performance by NovAtel under or related to this Agreement are to the remedies specified by this Agreement.
9. **Governing Law**: This Agreement is governed by the laws of the Province of Alberta, Canada. Each of the parties hereto irrevocably attorns to the jurisdiction of the courts of the Province of Alberta.

10. **Customer Support**: For Software UPDATES and UPGRADES, and regular customer support, contact the NovAtel GPS Hotline at 1-800-NOVATEL (U.S. or Canada only), or +1-403-295-4900, Fax +1-403-295-4901, email to support@novatel.ca, Web site: http://www.novatel.com or write to:

NovAtel Inc. Customer Service Department  
1120 - 68 Avenue NE  
Calgary, Alberta, Canada T2E 8S5
Terms and Conditions

Standard Terms and Conditions of Sales

1. PRICES: All prices are Firm Fixed Price, FCA 1120 - 68th Avenue N.E., Calgary, Alberta. All prices include standard commercial packing for domestic shipment. All transportation, insurance, special packing costs and expenses, and all Federal, provincial and local excise, duties, sales, and other similar taxes are the responsibility of the Purchaser.

2. PAYMENT: Terms are prepayment unless otherwise agreed in writing. Interest shall be charged on overdue accounts at the rate of 18% per annum (1.5% per month) from due date. To expedite payment by wire transfer to NovAtel Inc.: Bank - HSBC Bank of Canada

Bank: HSBC Bank of Canada
US Account #: 788889-002
407 - 8 Avenue S.W.
CDN Account #: 788889-001
Calgary, AB, Canada T2P 1E5
EURO Account #: 788889-270
Transit #: 10029-016
Swift: HKBCCATTCA

3. DELIVERY: Purchaser shall supply shipping instructions with each order. (Ship to and bill to address, NovAtel Quotation #, Preferred carrier and account #, Custom broker/freight forwarder including name and contact #) In the absence of specific instructions, NovAtel may select a carrier and insure Products in transit and charge Purchaser accordingly. NovAtel shall not be responsible for any failure to perform due to unforeseen circumstances or causes beyond its ability to reasonably control. Risk of loss, damage or destruction shall pass to Purchaser upon delivery to carrier. Goods are provided solely for incorporation into the Purchaser’s end product and shall not be onward delivered except as incorporated in the Purchaser’s end product.

4. COPYRIGHT AND CONFIDENTIALITY: Copyright in any specification, drawing, computer software, technical description and other document supplied by NovAtel under or in connection with the Order and all intellectual property rights in the design of any part of the Equipment or provision of services, whether such design be registered or not, shall vest in NovAtel absolutely. The Buyer shall keep confidential any information expressed or confirmed by NovAtel in writing to be confidential and shall not disclose it without NovAtel’s prior consent in writing to any third party or use it other than for the operation and maintenance of any Equipment provided.

5. GENERAL PROVISIONS: All Purchase Orders are subject to approval and acceptance by NovAtel. Any Purchase Order or other form from the Purchaser, which purports to expand, alter or amend these terms and conditions, is expressly rejected and is and shall not become a part of any agreement between NovAtel and the Purchaser. This agreement shall be interpreted under the laws of the Province of Alberta.
6. LIMITED WARRANTY AND LIABILITY: Warranty Period: Products - 1 year; Accessories - 90 days (in each case from the date of invoice). NovAtel warrants that during the Warranty Period that (a) the Product will be free from defects in material and workmanship and conform to NovAtel specifications; (b) the software will be free from error which materially affect performance; and (c) if applicable as defined in the User’s Manual, be eligible for access to post contract support and software updates when available. **THESE WARRANTIES ARE EXPRESSLY IN LIUE OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.** NovAtel shall in no event be liable for special, indirect, incidental, or consequential damages of any kind or nature due to any cause.

Purchaser’s exclusive remedy for a claim under this warranty shall be limited to the repair or replacement at NovAtel’s option and at NovAtel’s facility, of defective or nonconforming materials, parts or components or in the case of software, provision of a software revision for implementation by the Buyer. All material returned under warranty shall be returned to NovAtel prepaid by the Buyer and returned to the Buyer, prepaid by NovAtel. The foregoing warranties do not extend to (i) nonconformities, defects or errors in the Products due to accident, abuse, misuse or negligent use of the Products or use in other than a normal and customary manner, environmental conditions not conforming to NovAtel’s specifications, or failure to follow prescribed installation, operating and maintenance procedures, (ii) defects, errors or nonconformities in the Products due to modifications, alterations, additions or changes not made in accordance with NovAtel’s specifications or authorized by NovAtel, (iii) normal wear and tear, (iv) damage caused by force of nature or act of any third person, (v) shipping damage, (vi) service or repair of Product by the Purchaser without prior written consent from NovAtel, (vii) Products designated by NovAtel as beta site test samples, experimental, developmental, preproduction, sample, incomplete or out of specification Products, (viii) returned Products if the original identification marks have been removed or altered or (ix) Services or research activities.

7. EXCLUSION OF LIABILITY: If a Party would, but for this paragraph (7), have concurrent claims in contract and tort (including negligence) such claims in tort (including negligence) shall to the extent permitted by law be wholly barred, unenforceable and excluded.

NovAtel shall not be liable to the Buyer by way of indemnity or by reason of any breach of the Order or of statutory duty or by reason of tort (including but not limited to negligence) for any loss of profit, loss of use, loss of production, loss of contracts or for any financing costs or for any indirect or consequential damage whatsoever that may be suffered by the Buyer.

In the event and to the extent that NovAtel shall have any liability to Buyer pursuant to the terms of the Order, NovAtel shall be liable to Buyer only for those damages which have been foreseen or might have reasonably been foreseen on the date of effectivity of the Order and which are solely an immediate and direct result of any act or omission of NovAtel in performing the work or any portion thereof under the Order and which are not in the aggregate in excess of ten (10%) percent of the total Order price.
NovAtel Inc. warrants that its products are free from defects in materials and workmanship, subject to the conditions set forth below, for the following periods of time, from the date of sale:

<table>
<thead>
<tr>
<th>Product</th>
<th>Warranty Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART-AG</td>
<td>One (1) Year</td>
</tr>
<tr>
<td>Antenna</td>
<td>One (1) Year</td>
</tr>
<tr>
<td>Cables and Accessories</td>
<td>Ninety (90) Days</td>
</tr>
<tr>
<td>Computer Discs</td>
<td>Ninety (90) Days</td>
</tr>
<tr>
<td>Software Warranty</td>
<td>One (1) Year</td>
</tr>
</tbody>
</table>

Date of sale shall mean the date of the invoice to the original customer for the product. NovAtel’s responsibility respecting this warranty is solely to product replacement or product repair at an authorized NovAtel location, or in the case of software, provision of a software revision for implementation by the customer.

Determination of replacement or repair will be made by NovAtel personnel or by technical personnel expressly authorized by NovAtel for this purpose.

THE FOREGOING WARRANTIES DO NOT EXTEND TO (I) NONCONFORMITIES, DEFECTS OR ERRORS IN THE PRODUCTS DUE TO ACCIDENT, ABUSE, MISUSE OR NEGLIGENT USE OF THE PRODUCTS OR USE IN OTHER THAN A NORMAL AND CUSTOMARY MANNER, ENVIRONMENTAL CONDITIONS NOT CONFORMING TO NOVATEL’S SPECIFICATIONS, OR FAILURE TO FOLLOW PRESCRIBED INSTALLATION, OPERATING AND MAINTENANCE PROCEDURES, (II) DEFECTS, ERRORS OR NONCONFORMITIES IN THE PRODUCTS DUE TO MODIFICATIONS, ALTERATIONS, ADDITIONS OR CHANGES NOT MADE IN ACCORDANCE WITH NOVATEL’S SPECIFICATIONS OR AUTHORIZED BY NOVATEL, (III) NORMAL WEAR AND TEAR, (IV) DAMAGE CAUSED BY FORCE OF NATURE OR ACT OF ANY THIRD PERSON, (V) SHIPPING DAMAGE; OR (VI) SERVICE OR REPAIR OF PRODUCT BY THE DEALER WITHOUT PRIOR WRITTEN CONSENT FROM NOVATEL. IN ADDITION, THE FOREGOING WARRANTIES SHALL NOT APPLY TO PRODUCTS DESIGNATED BY NOVATEL AS BETA SITE TEST SAMPLES, EXPERIMENTAL, DEVELOPMENTAL, PREPRODUCTION, SAMPLE, INCOMPLETE OR OUT OF SPECIFICATION PRODUCTS OR TO RETURNED PRODUCTS IF THE ORIGINAL IDENTIFICATION MARKS HAVE BEEN REMOVED OR ALTERED. THE WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, WRITTEN OR ORAL, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE ARE EXCLUDED. NOVATEL SHALL NOT BE LIABLE FOR ANY LOSS, DAMAGE, EXPENSE, OR INJURY ARISING DIRECTLY OR INDIRECTLY OUT OF THE PURCHASE, INSTALLATION, OPERATION, USE OR LICENSING OR PRODUCTS OR SERVICES. IN NO EVENT SHALL NOVATEL BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND OR NATURE DUE TO ANY CAUSE.

There are no user serviceable parts in the NovAtel receiver and no maintenance is required. When the status code indicates that a unit is faulty, replace with another unit and return the faulty unit to NovAtel Inc.

Before shipping any material to NovAtel or Dealer, please obtain a Return Material Authorization (RMA) number from the point of purchase. You may also visit our Web site at http://www.novatel.com and select Support | Repair Requests from the top menu.

Once you have obtained an RMA number, you will be advised of proper shipping procedures to return any defective product. When returning any product to NovAtel, please return the defective product in the original packaging to avoid ESD and shipping damage.
The following notices apply to the SMART-AG. For more information on emissions testing, please refer to the regulatory body in your geographic area. For example, in the US that is the Federal Communications Commission (FCC) and in Europe the Conformité Européenne (CE).

**FCC**

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

SMART-AG-PVT, SMART-AG-PVT-G, SMART-AG-PVT-S and SMART-AG-PVT-RT20 have been tested and found to comply with the emission limits for a Class A digital device. The SMART-AG-B and SMART-AG-TB comply with the emission limits for a Class B digital device. The Class B limits are designed to provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re-orient or relocate the SMART-AG
- Increase the separation between the equipment and the SMART-AG
- Connect the equipment to an outlet on a circuit different from that to which the SMART-AG is connected
- Consult the dealer or an experienced radio/TV technician for help

**IMPORTANT:**

In order to maintain compliance as a Class “A” or Class “B” digital device, shielded cables should be used for the RS-232 serial data ports (Belden 1036A or equivalent) and twisted pair cable should be used for the CAN port (shielded twisted pair will improve CAN performance in electrically harsh environments). I/O signals should be referred to signal ground (connector pin 5) and not power ground (connector pin 9). If I/O signals route to different areas of the vehicle, dedicated signal grounds for I/O should be spliced into a common connection to connector pin 5 at a point close to the SMART-AG.

**WARNING:**

Changes or modifications to this equipment not expressly approved by NovAtel Inc. could result in violation of Part 15 of the FCC rules and void the user’s authority to operate this equipment.
**Industry Canada**

SMART-AG-PVT, SMART-AG-PVT-G, SMART-AG-PVT-S and SMART-AG-PVT-RT20 Class A digital apparatuses all comply with Canadian ICES-003.

SMART-AG-PVT, SMART-AG-PVT-G, SMART-AG-PVT-S et le SMART-AG-PVT-RT20 appareils numérique de la classe B sont conforme à la norme NMB-003 du Canada.

SMART-AG-B and SMART-AG-TB Class B digital apparatuses comply with Canadian ICES-003.

SMART-AG-B et SMART-AG-TB appareils numérique de la classe B sont conforme à la norme NMB-003 du Canada.

**CE**

The enclosures carry the CE mark.

"Hereby, NovAtel Inc. declares that this SMART-AG is in compliance with the essential requirements and other relevant provisions of the R&TTE Directive 1999/5/EC and with the EMC Directive 2004/108/EC."

**WEEE**

If you purchased your OEMV family product in Europe, please return it to your dealer or supplier at the end of its life. The objectives of the European Community's environment policy are, in particular, to preserve, protect and improve the quality of the environment, protect human health and utilise natural resources prudently and rationally. Sustainable development advocates the reduction of wasteful consumption of natural resources and the prevention of pollution. Waste electrical and electronic equipment (WEEE) is a regulated area. Where the generation of waste cannot be avoided, it should be reused or recovered for its material or energy. WEEE products may be recognized by their wheeled bin label ("🗑️").

**RoHS**

The SMART-AG is compliant with the European Union (EU) Restriction of Hazardous Substances (RoHS) Directive 2002/95/EC.

---

1. Please visit the NovAtel Web site at [http://www.novatel.com/support/weee.htm](http://www.novatel.com/support/weee.htm) for more information on WEEE and RoHS.
OEMV Firmware UPGRADES

Firmware upgrades are firmware releases, which increase basic functionality of the receiver from one model to a higher level model type. When available, upgrades may be purchased at a price, which is the difference between the two model types on the current NovAtel GPS Price List plus a nominal service charge.

WINLOAD

Please refer to the OEMV Family Installation and Operation User Manual for instructions on how to use the WinLoad program to upgrade your OEMVcard.

Contact Information

Model upgrades are accomplished through NovAtel authorized dealers.

Contact your local NovAtel dealer first for more information. To locate a dealer in your area or if the problem is not resolved, contact NovAtel Inc. directly using one of the following methods:

Call the NovAtel GPS Hotline at 1-800-NOVATEL (U.S. & Canada), or 403-295-4900 (international)
Fax: 403-295-4901
E-mail: support@novatel.com
Web site: http://www.novatel.com
Write: NovAtel Inc., Customer Service Dept., 1120 - 68 Avenue NE, Calgary, AB., Canada, T2E 8S5

Before contacting NovAtel Customer Service regarding software concerns, please do the following:

1. Issue a FRESET command

2. Log the following data to a file on your PC/laptop for 30 minutes
   
   RXSTATUSA once
   BESTPOSA ontime 1
   RXCONFIGA once
   VERSIONA once

3. Send the file containing the logs to NovAtel Customer Service, using either the NovAtel ftp site at ftp://ftp.novatel.com/incoming or the support@novatel.com e-mail address.
Congratulations!

Congratulations on your purchase of the SMART-AG, a GPS L1 plus GLONASS L1 receiver and antenna with exceptional flexibility and performance.

NovAtel is an industry leader in state-of-the-art Global Navigation Satellite Systems (GNSS) receiver design. We believe that our SMART-AG will meet your high expectations, and are working hard to ensure that future products and enhancements maintain that level of satisfaction.

This is your primary hardware and software reference.

Scope

This manual provides sufficient detail on the SMART-AG, to allow you to effectively integrate and fully operate it. The information in this manual is a companion to the OEMV family information in the OEMV Firmware Reference Manual and the OEMV Installation and Operation User Manual.

After the addition of accessories and a power supply, the SMART-AG is ready to go.

SMART-AG utilizes a comprehensive user-interface command structure, which requires communications through its communications (COM) ports. This manual describes the SMART-AG-specific commands and logs, see Commands starting on Page 64 and Logs starting on Page 73. Other supplementary manuals, available on the accompanying CD and on our Web site at http://www.novatel.com/support/docupdates.htm, aid you in using the other commands and logs available in the OEMV family of receivers.

PC Utilities are also described, see Chapter 4 starting on Page 37. Integrated with the Control and Display Unit (CDU) software, these utilities provide graphical user interfaces for logging to a PC/laptop, upgrading, and converting data types.

Prerequisites

The installation chapters of this document provide information concerning the installation requirements and considerations for SMART-AG. To run the PC software supplied, your personal computer must meet or exceed this minimum configuration:

- Windows compatible mouse or pointing device and SVGA display

Although previous experience with Windows is not necessary to use CDU, familiarity with certain actions that are customary in Windows will assist in the usage of the program. This manual has been written with the expectation that you already have a basic familiarity with Windows.

What’s New in Rev 4 of this Manual?

This manual has been revised to include information on the following:

- Tilt compensation, see “Tilt Compensation” on page 26.
• Bluetooth®, see “Bluetooth on the SMART-AG Receiver” on page 54.

Conventions

Conventions used in this manual are the following:

- The letter H in the Offset columns of the commands and logs tables represents the header length for that command or log. Refer to the OEMV Family Firmware Reference Manual for ASCII and binary header details.
- The number following 0x is a hexadecimal number.
- Command descriptions’ brackets, [ ], represent the optionality of parameters.
- In tables where values are missing they are assumed to be reserved for future use.
- Status words are output as hexadecimal numbers and must be converted to binary format (and in some cases then also to decimal). For an example of this type of conversion, please refer to the RANGE log in the OEMV Family Firmware Reference Manual.

Conversions and their binary or decimal results are always read from right to left. For a complete list of hexadecimal, binary and decimal equivalents, please refer to the Unit Conversion section of the GNSS Reference Book available on our Web site at http://www.novatel.com/support/docupdates.htm.

See also Section B.1, Syntax Conventions on Page 64 for more syntax when entering commands.
The SMART-AG is a high-performance GNSS receiver and antenna, capable of receiving and tracking different combinations of GPS L1 and GLONASS L1 code and carrier signals on a maximum of 36 channels. SBAS (Satellite Based Augmentation Systems) includes WAAS, EGNOS, and MSAS. SBAS support is standard. Refer to the *GNSS Reference Book* for an overview of each of the above signal types, available from our Web site at [http://www.novatel.com/support/docupdates.htm](http://www.novatel.com/support/docupdates.htm). The SMART-AG’s rear panel also features light emitting diodes (LEDs) for status indication.

Once you connect the SMART-AG to a vehicle, it begins operating as a fully functional GNSS system. *Figure 1* below shows the SMART-AG without connecting cables.

![Figure 1: SMART-AG Receiver](image)

### 1.1 Models and Features

The main features of the SMART-AG are the following:

- an enhanced high performance GPS+GLONASS L1 receiver
- a high performance GPS+GLONASS L1 antenna
- emulated radar output
- a CAN port
- two (2) RS-232 COM ports
- three (3) LED status indicators
- a water and dust tight enclosure
- *Bluetooth* (optional)
- tilt compensation (optional)
The SMART-AG is available in several different firmware models whose configurations may include other additional features. Some possible configurations can be seen in Table 1 below.

**Table 1: SMART-AG Controller Models**

<table>
<thead>
<tr>
<th>Model Name</th>
<th>Firmware Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART-AG-PVT</td>
<td>GPS L1 only Autonomous, SBAS, or DGPS 20 Hz positions with emulated radar output</td>
</tr>
<tr>
<td>SMART-AG-PVT-G</td>
<td>As above with GLONASS L1</td>
</tr>
<tr>
<td>SMART-AG-PVT-S</td>
<td>GPS L1 only Autonomous, SBAS, or DGPS 5 Hz positions without emulated radar output</td>
</tr>
<tr>
<td>SMART-AG-RT20</td>
<td>GPS L1 only Autonomous, SBAS, DGPS, or 20 cm RT-20 positions</td>
</tr>
<tr>
<td>SMART-AG-PVT-U</td>
<td>GPS L1 only Autonomous, SBAS, or DGPS 5 Hz positions with emulated radar output</td>
</tr>
</tbody>
</table>

Refer also to the *OEMV Family Installation and Operation User Manual* for information on receiver communications and operation.
Chapter 2  Installation and Setup

This chapter contains instructions and tips to set up your SMART-AG to create a GNSS receiver system.

2.1  Additional Equipment Required

In order for the receiver to perform optimally, the following additional equipment is required:

- A PC/laptop (user-supplied)
- A means of communicating with, and powering, the SMART-AG
  - SMART-AG cable (01018256) (included with the receiver Development Kit), NovAtel part number 01018257, see Figure 3, Simplified SMART-AG Setup on Page 22 for COM and power connections
  - Use a serial COM connection to communicate with the receiver first.

- A fused power supply (user-supplied) or other user equipment

2.1.1  SMART-AG Setup

Complete the following steps to connect and power your SMART-AG.

1. Mount the SMART-AG on a secure, stable part of the vehicle (i.e. cab roof) with an unobstructed view of the sky from horizon to horizon, see Section 2.1.5, Mounting the SMART-AG on Page 23.

2. Establish a physical communication connection between the SMART-AG and the PC/laptop. Connect the COM and Power port on the back of the SMART-AG, see Figure 2 below, to a DB-9 serial port on a PC, laptop or other data storage device.

![Figure 2: SMART-AG Connector](image)
3. Turn on the power supply to the SMART-AG (the SMART-AG cable is also a power cable). The power LED on the back of the receiver glows red when the SMART-AG is properly powered.

FUse/holder recommendations can be found in Table 8, Recommended Fuse and Fuse Holders on page 65.

### Table 2: SMART-AG Connector Pin-Out

<table>
<thead>
<tr>
<th>Pin</th>
<th>Use</th>
<th>Pin</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM 1 TxD</td>
<td>8</td>
<td>RESERVED (Do not connect)</td>
</tr>
<tr>
<td>2</td>
<td>COM 1 RxD</td>
<td>9</td>
<td>Power Negative/Return</td>
</tr>
<tr>
<td>3</td>
<td>COM 2 TxD</td>
<td>10</td>
<td>Emulated Radar Output</td>
</tr>
<tr>
<td>4</td>
<td>COM 2 RxD</td>
<td>11</td>
<td>MKI (Mark Input)</td>
</tr>
<tr>
<td>5</td>
<td>Signal Ground (COM/ER/MKI/PPS)</td>
<td>12</td>
<td>PPS (Pulse Per Second) Output</td>
</tr>
<tr>
<td>6</td>
<td>CAN+</td>
<td>13</td>
<td>RESERVED (Do not connect)</td>
</tr>
<tr>
<td>7</td>
<td>CAN-</td>
<td>14</td>
<td>Power Positive/Source</td>
</tr>
</tbody>
</table>

![SMART-AG Connector Diagram]
2.1.2 Installing the PC Utilities

Once the SMART-AG is connected to the PC/laptop and a power supply, install NovAtel’s PC Utilities. These include CDU, a graphical user interface program.

1. Start up the PC/laptop.
2. Insert the accompanying CD, see Figure 4 below, in the CD-ROM drive of the computer.
3. Select Install the OEMV GPS PC Utilities from the window that is automatically displayed.

If the window does not automatically open when the CD is inserted, select Run from the Start menu and select the Browse button to locate Setup.exe on the CD drive.

4. Install the PC Utilities by advancing through the steps provided in the NovAtel PC Utilities setup program.

2.1.3 Power Supply Requirements

The SMART-AG requires +8 to +36 VDC for the input power to the receiver. See Page 60 for more power supply specifications.

The SMART-AG cable provides power in (with a BATT+ label) and power ground (with a BATT-label) bare wires for connections from the SMART-AG to a 12 to 24V vehicular power system (or equivalent) protected by a 5A Fast Blow Fuse (user supplied). See its cable details starting on Page 64.

⚠️ WARNING!: The SMART-AG power source must be protected by a 5A Fast Blow Fuse or damage to wiring may result (not covered by warranty). If the voltage supplied is above or below the specified range, the receiver will suspend operation. If the voltage supplied is above 48V, the receiver may be permanently damaged, voiding your warranty.
2.1.4 Mounting Plate

A mounting plate is available to facilitate mounting the receiver to a surface.

![SMART-AG Mounting Plate](image)

*Figure 5: SMART-AG Mounting Plate*

- All measurements are in inches unless specified otherwise.

To install the mounting plate provided with the SMART-AG Development Kit, use the adhesive tape attached or the mounting holes at each corner of the plate.

2.1.5 Mounting the SMART-AG

The SMART-AG is a single-frequency GNSS receiver and antenna.

When installing the SMART-AG, do the following:

- Choose a location that has a clear view of the sky so that each satellite above the horizon can be tracked without obstruction. For more information, refer to the GNSS Reference Book found at [http://www.novatel.com/support/docupdates.htm](http://www.novatel.com/support/docupdates.htm).
- Mount on a secure, stable structure capable of safe operation in the specific environment. Typical installation is the tractor cab roof, ideally close to the pivot point of the tractor.

See [2.2.5.1 Physical Installation on Page 26](#) for additional requirements.

2.1.6 Connecting Data Communications Equipment

To communicate with the receiver by sending commands and obtaining logs, a connection to data communications equipment is required. See the SMART-AG Cable Pinouts table on Page 63 for more
2.2 Additional Features and Information

This section contains information on the additional features of the SMART-AG, which may affect the overall design of your receiver system.

2.2.1 MKI and PPS Strobes

An input (MKI) and output (PPS) strobe provide status and synchronization signals. PPS is a 3.3V CMOS output; MKI is a 5V logic tolerant input.

Pin-out information can also be found on Page 63.

2.2.2 Status Indicators

LED indicators on the SMART-AG provide the status of the receiver. They represent these categories:

- Position Status
- Position Type
- Power

Table 3 shows the meaning of the LED states in the expected sequence after power is applied.

<table>
<thead>
<tr>
<th>Red</th>
<th>Yellow</th>
<th>Green</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Power is not available. (Red indicator may also not be lit if a boot failure has occurred.)</td>
</tr>
<tr>
<td>On</td>
<td>Off</td>
<td>Off</td>
<td>Power available but no satellites are tracking yet</td>
</tr>
<tr>
<td>On</td>
<td>Flashing</td>
<td>Off</td>
<td>Tracking at least one satellite but not a valid position</td>
</tr>
<tr>
<td>On</td>
<td>On</td>
<td>Off</td>
<td>Position valid in basic autonomous mode</td>
</tr>
<tr>
<td>On</td>
<td>On</td>
<td>Flashing</td>
<td>SBAS tracking, but not enough data for enhanced solution.</td>
</tr>
<tr>
<td>On</td>
<td>On</td>
<td>On</td>
<td>Position valid in an enhanced accuracy mode (WAAS/EGNOS/MSAS/DGPS or RTK)</td>
</tr>
</tbody>
</table>

Flashing means that the LED is turning on and off at a 1 Hz rate - 0.5 seconds on and 0.5 seconds off.

Debugging:

- If the power is on but the yellow LED doesn’t flash within one minute, then no satellites are
tracking. There may be excessive blockage or the unit may be defective. Make sure the unit has an unobstructed view of the sky. Try power cycling the unit.

- If the yellow LED is flashing but doesn't progress to solid yellow within one minute, then insufficient satellites are tracking or the signal quality is poor and ephemeris data can’t be received. Normally, four satellites are sufficient for a valid position as long as they are widely distributed in the sky. If it is stuck on blinking yellow, there may be excessive blockage or the unit may be defective. Make sure the unit has an unobstructed view of the sky. Try power cycling the unit.

- If the yellow LED is on, but the green doesn’t turn on within five minutes than no SBAS or DGPS positions are available. If you are using SBAS, make sure SBAS is available in your area and that the unit is configured to enable SBAS positions (SBASCONTROL ENABLE). For DGPS, make sure the unit is configured with the correct serial port parameters and to accept the DGPS protocol your area is using and that your data modem is connected and working.

- The green LED blinks when SBAS is detected then it comes on solid when SBAS is enabled. The LED will stay dark if SBAS is not detected.

2.2.3 Emulated Radar (ER)

The SMART-AG outputs an emulated RADAR signal via the bare wires labeled ER GND and ER_OUT on the SMART-AG cable. See Table 7 on Page 64 for the pin-out details of this cable.

The ER outputs a logic high of supply voltage minus 0.5V minimum and logic low of 0.5V maximum with a rise and fall time of less than 1 ms. Its output references signal GND and provides logic low output until its speed is greater than 1 km/Hr. ER can be configured to operate at one of three distinct frequencies (26.11, 28.12 or 36.11 Hz/km/Hr, with 26.11 Hz/km/Hr being the default value) and with an effective range from 1 km/Hr to 55 km/Hr for near-horizontal applications. See B.4, RADARCFG Configure the ER Output starting on Page 71 for more information.

2.2.4 Controller Area Network (CAN)

NMEA 2000 is a CAN standard created by the National Marine Electronics Association and designed to support networking in marine applications. It functions over a longer physical distance, and supports more physical nodes than ISO 11783. The relationship between NMEA2000 and SAE J1939 is that J1939 is the standard, while the NMEA 2000 group has added some new messages (called PGNs or Parameter Group Numbers) and added a new, additional transport protocol called FastPacket. NMEA2000 compliant, for all intents and purposes, means J1939 compliant plus support for new NMEA2000 messages. In other word, one cannot have NMEA2000 without J1939 support as well. J1939 is additionally “harmonized” with ISO 11783, a standard for the agriculture industry.
The CAN module is generally not user-interactive. It is activated when a SETCANNNAME command is entered, and after a SAVECONFIG, the CAN module is activated immediately on all subsequent start-ups. The module supports the following NMEA2000 Parameter Group Message (PGN):

- PGN 129029 GNSSPositionData
- PGN 129025 GNSSPositionRapidUpdate
- PGN 129026 COGandSOGRapidUpdate

### Table 4: Available CAN Signals on the SMART-AG

<table>
<thead>
<tr>
<th>CAN</th>
<th>Pins</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANI+</td>
<td>Pin 6</td>
</tr>
<tr>
<td>CANI-</td>
<td>Pin 7</td>
</tr>
</tbody>
</table>

### 2.2.5 Tilt Compensation

To fully install and set up tilt compensation:

1. Mount the SMART-AG on the vehicle.
2. Measure, set, and save the height of the SMART-AG from the ground.
3. Level the tilt sensor and save the data.

#### 2.2.5.1 Physical Installation

The SMART-AG must be mounted as close to the center of the vehicle as possible, as illustrated in Figure 6.
The SMART-AG must be mounted with the connector facing the rear of the vehicle, as shown in Figure 7:

![Figure 7: SMART-AG Orientation](image)

The SMART-AG must be rigidly secured to the vehicle, to minimize errors due to vibration and motion.

### 2.2.5.2 Height Measurement and Configuration

The height measurement should be made while the vehicle has the correct tire pressure and is parked on a hard-packed and level surface. The measurement should be made from the ground to the bottom of the SMART-AG connector. The measurement accuracy should be within 1 to 2 inches (2.5 to 5.0 cm).

Once the measurement has been made (in feet and inches, or metres), refer to Appendix B.5, $PMDT$ Configure Tilt Compensation starting on page 77 for instructions on how to set the height in the SMART-AG. The height must be saved after the height command is sent. This must be done so the height data is saved between power cycles. Instructions on sending the save command are outlined in Appendix B.5, $PMDT$ Configure Tilt Compensation starting on page 77.

Note that changes in tire pressure over time can potentially cause errors in tilt compensation. This is because the height of vehicle can vary with tire pressure.

The SMART-AG is shipped from the factory with the height set to 0.0 metres.

### 2.2.5.3 Leveling the Tilt Sensor

The vehicle must be parked on flat ground when the level command is sent to the SMART-AG. Refer to Appendix B.5, $PMDT$ Configure Tilt Compensation starting on page 77 for instructions on how to send the level command.

After the tilt sensor has been leveled, the data must be saved to non-volatile memory using the save command. Instructions on using the save command are outlined in Appendix B.5, $PMDT$ Configure Tilt Compensation starting on page 77.
Chapter 3  Operation

Before operating the SMART-AG for the first time, please ensure that you have followed the installation instructions in Chapter 2, Installation and Setup starting on Page 21. The following instructions are based on a COM port configuration such as that shown in Figure 9 on Page 32. It is assumed that a personal computer (PC), or laptop, is used during initial operation and testing for greater ease and versatility.

3.1  Communications with the Receiver

Communication with the receiver typically consists of issuing commands through the communication ports from an external serial communications device. This could be either a terminal or PC/laptop that is directly connected to the receiver serial port using a DB-9 connector on the SMART-AG multi-cable. If you are using a radio, it connects to another DB-9 connector on the same multi-cable by means of the radio serial cable supplied with the radio. It is recommended that you become thoroughly familiar with the commands and logs detailed in the OEMV Family Firmware Reference Manual to ensure maximum utilization of the receiver’s capabilities.

3.1.1  Serial Port Default Settings

The receiver communicates with your PC/laptop or terminal via an RS-232 serial port. For communication to occur, both the receiver and the operator interface have to be configured properly. The receiver’s COM1 and COM2 default port settings are as follows:

- 9600 bps, no parity, 8 data bits, 1 stop bit, no handshaking, echo off

Changing the default settings requires using the COM command. See Appendix B.2, COM Configure COM Port starting on Page 67 for details.

The data transfer rate you choose determines how fast information is transmitted. Take for example a log whose message byte count is 96. The default port settings allows 10 bits/byte (8 data bits + 1 stop bit + 1 framing bit). It therefore takes 960 bits per message. To get 10 messages per second then requires 9600 bps. Please also remember that even if you set the bps to 9600 the actual data transfer rate is lower and depends on the number of satellites being tracked, data filters in use, and idle time. It is suggested that you leave yourself a margin when choosing a data rate (115200 is recommended for most applications).

---

**CAUTION!** Although the receiver can operate at data transfer rates as low as 300 bps, this is not desirable. For example, if several data logs are active (that is, a significant amount of information needs to be transmitted every second) but the bit rate is set too low, data will overflow the serial port buffers, cause an error condition in the receiver status and result in lost data.

---
### 3.1.2 Communicating Using a Remote Terminal

One method of communicating with the receiver is through a remote terminal. The receiver has been pre-wired to allow proper RS-232 interface with your data terminal. To communicate with the terminal, the receiver only requires the RX, TX, and GND lines to be used. Request to Send (RTS)/Clear to Send (CTS) hardware handshaking is not available. Ensure the terminal’s communications set-up matches the receiver’s RS-232 protocol.

### 3.1.3 Communicating Using a Personal Computer

An IBM-compatible PC/laptop can be set up to emulate a remote terminal as well as provide the added flexibility of creating multiple-command batch files and data logging storage files. Any standard communications software package that emulates a terminal can be used to establish bidirectional communications with the receiver, for example, HyperTerminal or our own graphic user interface (GUI) program, **CDU**. All data is sent as raw 8-bit binary or ASCII characters.

### 3.2 Getting Started

Included with your receiver are NovAtel’s **CDU** and Convert programs. **CDU** is a windows-based GUI which allows you to access the receiver’s many features without the need for communications protocol or to write special software. The Convert utility is a windows-based utility that allows you to convert between file formats, and strips unwanted records for data file compilation. See also Page 22.

#### 3.2.1 Starting the Receiver

When first powered, the SMART-AG undergoes a complete self-test. If an error condition is detected during a self-test, the self-test status word changes. This self-test status word can be viewed in the header of any data output log. Refer to the chapter on *Messages* in the OEMV Family Firmware Reference Manual for header information. If a persistent error develops, please contact your local NovAtel dealer first. If the problem is still unresolved, please contact NovAtel directly through any of the methods listed in the Customer Service section at the beginning of this manual on Page 16.
3.2.2 Communicating with the Receiver Using CDU

Launch the CDU program and select Device | Open from its main menu. The Open Configuration window appears. Figure 8, below, shows an Open Configuration window with two possible configurations already set up. Your configurations may be different or you may have none at all, in which case, the Open Configuration window is empty.

![Open Configuration Window](image.png)

Refer to CDU’s help file by selecting the Help | Contents menu. Ensure you can see the Console and ASCII Messages windows by selecting them from the View menu.

When the receiver is first turned on, no data is transmitted from the COM ports except for the port prompt. The console window displays a port name:

- [COM1] if connected to COM1 port,
  or
- [COM2] if connected to COM2 port,

Any of the above prompts indicate that the receiver is ready and waiting for command input.

1. You may also have to wait for output from receiver self tests. For example, on start-up, the OEMV family receiver is set to log the RXSTATUSEVENTA log ONNEW on all ports. Refer to the OEMV Family Firmware Reference Manual for more details.

2. If you find that CDU is unable to locate your OEMV family receiver, it may be that you have previously used the SAVECONFIG command. In this case, try using a different COM port to communicate to the receiver. Once communication has been established, issue the command FRESET STANDARD. You should now be able to use your original communication port again.
Commands are typed at the interfacing computing device’s keypad or keyboard, and executed after issuing a carriage return command which is usually the same as pressing the <Enter> key.

An example of a response to an input command is the FIX POSITION command. It can be as:

```
[COM2] fix position 51.11635 -114.0383 1048.2 [carriage return]
<OK
```

where [COM2] is the port prompt, followed by the command you enter from your keypad or keyboard and [carriage return] indicates that you should press the <Enter> key.

The example above illustrates the command input to the base receiver’s COM2 port, which sets the position of the base station receiver for differential operation. Confirmation that the command was actually accepted is the appearance of <OK.

If a command is entered incorrectly, the receiver responds with:

```
<INVALID MESSAGE ID (or a more detailed message)
```

---

**WARNING!** Ensure the Control Panel’s Power Settings on your PC/laptop are not set to go into Hibernate or Standby modes. Data will be lost if one of these modes occurs during a logging session.

---

### 3.3 Transmitting and Receiving Corrections

RTK or DGPS corrections can be transmitted from a base station to a rover station to improve position accuracy. The base station is the GNSS receiver, which is acting as the stationary reference. It has a known position and transmits correction messages to the rover station. The rover station is the GNSS receiver which does not know its exact position and can be sent correction messages from a base station to calculate differential GNSS positions. The SMART-AG can be used as a base receiver to transmit RTK or DGPS corrections or a rover to receive the same corrections. An example of a differential setup is given in *Figure 9 on Page 32.*
System biases can introduce errors, refer to our *GNSS Reference Book* found on our Web site at [http://www.novatel.com/support/docupdates.htm](http://www.novatel.com/support/docupdates.htm) for more information. In most cases you need to provide a data link between the base station and rover station (two NovAtel receivers) in order to receive corrections. SBAS corrections can be accomplished with one receiver and are exceptions to the base/rover concept. Generally a link capable of data throughput at a rate of 9600 bits per second, and less than 4.0 s latency, is recommended.

Once your base and rover are set up, you can configure them as shown in the configuration examples that follow in Sections 3.3.1 - 3.3.2 starting on Page 33.

### Figure 9: Basic Differential Setup

<table>
<thead>
<tr>
<th>Reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SMART-AG receiver</td>
</tr>
<tr>
<td>2</td>
<td>User-supplied 5A fast blow fuse</td>
</tr>
<tr>
<td>3</td>
<td>User-supplied power supply, for example a battery</td>
</tr>
<tr>
<td>4</td>
<td>User-supplied device to COM1</td>
</tr>
<tr>
<td>5</td>
<td>User-supplied radio device to COM2</td>
</tr>
<tr>
<td>6</td>
<td>User-supplied PC/laptop, for setting up and monitoring, to COM1</td>
</tr>
</tbody>
</table>
3.3.1 **Base Station Configuration**

At the base station, enter the following commands:

```plaintext
interfacemode port rx_type tx_type [responses]
fix position latitude longitude height
log port message [trigger [period]]
```

Examples of these commands include the following:

**RTCA**

```plaintext
interfacemode com2 none rtca off
fix position 51.11358042 -114.04358013 1059.4105
log com2 rtcaobs ontime 1
log com2 rtcaref ontime 10
log com2 rtca1 ontime 5  (optional for rtk)
log com2 rtcaephem ontime 10 1  (optional)
```

**RTCM**

```plaintext
interfacemode com2 none rtcm off
fix position 51.11358042 -114.04358013 1059.4105
log com2 rtcm3 ontime 10  (required for RTK)
log com2 rtcm22 ontime 10 1  (optional)
log com2 rtcm1819 ontime 1
log com2 rtcm1 ontime 5
```

**RTCMV3**

```plaintext
interfacemode com2 none rtcmv3 off
fix position 51.11358042 -114.04358013 1059.4105
log com2 rtcm1006 ontime 10
log com2 rtcm1003 ontime 1
```

**CMR+**

```plaintext
interfacemode com2 none cmr off
fix position 51.11358042 -114.04358013 1059.4105
log com2 cmrobs ontime 1
log com2 cmrplus ontime 1  (important to use ontime 1 with cmrplus)
```

**CMR**

```plaintext
interfacemode com2 none cmr off
fix position 51.11358042 -114.04358013 1059.4105
log com2 cmrobs ontime 1
log com2 cmrref ontime 10
log com2 cmrdesc ontime 10 1
```
### 3.3.2 Rover Station Configuration

At the rover station, enter:

```
interfacemode port rx_type tx_type [responses]
```

For example:

- **RTCA**
  
  ```
  interfacemode com2 rtca none off
  ```

- **RTCM**
  
  ```
  interfacemode com2 rtcm none off
  ```

- **RTCMV3**
  
  ```
  interfacemode com2 rtcmv3 none off
  ```

- **CMR+**
  
  ```
  interfacemode com2 cmr none off
  ```

- **CMR**
  
  ```
  interfacemode com2 cmr none off (same as CMR+)
  ```

### 3.3.3 GPS + GLONASS Base and Rover Configuration

This section shows you how to set up your base and rover OEMV GPS + GLONASS-enabled receivers for GPS + GLONASS RTK operation:

**Base Station:**

```
fix position lat lon hgt (enter your own lat, lon, and hgt values)
com com2 9600 N 8 1 N off
interfacemode com2 none rtca off
log com2 rtcaref ontime 10
log com2 rtcaobs2 ontime 1
log com2 rtca1 ontime 5 (optional, enable code-DGPS coverage)
saveconfig (optional, save configuration to non-volatile memory)
```

**Rover Station:**

```
com com2 9600 N 8 1 N off
interfacemode com2 rtca none off
log com1 bestposa ontime 1 (optional, view position information)
saveconfig (optional, save configuration to non-volatile memory)
```

### 3.3.4 Configuration Notes

For compatibility with other GNSS receivers, and to minimize message size, it is recommended that you use the standard form of RTCA, RTCM, RTCMV3 or CMR corrections as shown in the base and rover examples above. This requires using the INTERFACEMODE command to dedicate one direction of a serial port to only that message type. When the INTERFACEMODE command is used to change the mode from the default, NOVATEL, you can no longer use NovAtel format messages.
If you wish to mix NovAtel format messages and RTCA, RTCM, RTCMV3 or CMR messages on the same port, you can leave the INTERFACEMODE set to NOVATEL and log out variants of the standard correction messages with a NovAtel header. ASCII or binary variants can be requested by simply appending an "A" or "B" to the standard message name. For example on the base station:

```
interfacemode com2 novatel novatel
fix position 51.11358042 -114.04358013 1059.4105
log com2 rtcm1b ontime 2
```

- Using the receiver in this mode consumes more CPU bandwidth than using the native differential messages as shown in Section 3.3.1, Base Station Configuration on Page 33.

At the rover station you can leave the INTERFACEMODE default settings (interfacemode com2 novatel novatel). The rover receiver recognizes the default and uses the corrections it receives with a NovAtel header.

The PSRDIFFSOURCE and RTKSOURCE commands set the station ID values which identify the base stations from which to accept pseudorange or RTK corrections respectively. They are useful commands when the rover station is receiving corrections from multiple base stations. Refer to the GNSS Reference Book for more information on SBAS, available from our Web site at: http://www.novatel.com/support/docupdates.htm

- All PSRDIFFSOURCE entries fall back to SBAS (even NONE) for backwards compatibility.

At the base station it is also possible to log out the contents of the standard corrections in a form that is easier to read or process. These larger variants have the correction fields broken out into standard types within the log, rather than compressed into bit fields. This can be useful if you wish to modify the format of the corrections for a non-standard application, or if you wish to look at the corrections for system debugging purposes. These variants have "DATA" as part of their names (for example, RTCADATA1, RTCMDATA1, CMRDATAOBS, and more). Refer also to the OEMV Family Firmware Reference Manual, which describes the various message formats in more detail.

- Information on how to send multiple commands and log requests using DOS or Windows, can be found on our Web site at http://www.novatel.com/support/knowledgedb.htm.

### 3.3.5 EGNOS

EGNOS (European Geostationary Navigation Overlay Service) has been developed to work with existing satellite navigation systems to improve the accuracy of navigation signals. The EGNOS signal is transmitted by two geostationary satellites and covers all of Europe. EGNOS transmits a signal containing information on the reliability and accuracy of the positioning signals sent out by GPS.

ESTB (EGNOS System Test Bed) is a reduced version of EGNOS using dedicated monitoring stations and processing devices. EGNOS and ESTB are two independent systems making use of its own
ground segment infrastructure and different GEOs. EGNOS and ESTB broadcast two different signals.

The ESTB is broadcasted on PRN (pseudorandom number) 126 and EGNOS is broadcasted on PRNs 120 and 124.

Due to the experimental nature of the ESTB, the signals are broadcast without any guarantee of service.

- Use of the ESTB signal is not recommended by NovAtel. Use this command to prevent tracking PRN 126:
  
  ```
  WAAS17 0 1 0 126 255 0 0 0 0 0 0.
  ```

EGNOS entered its pre-operational phase in 2006 and at the time of writing is still in test mode and so the signal broadcast by the EGNOS satellites (via PRNs 120 & 124) should be used with caution. By default NovAtel receivers will not use SBAS signals in test mode. If you wish to use these signals you must issue the following command:

```
 sbascontrol enable egnos 0 zerototwo
```

More information on the ESTB can be found at [http://www.esa.int/estb](http://www.esa.int/estb). More information on EGNOS can be found at [http://www.esa.int/egnos](http://www.esa.int/egnos).

### 3.4 GL1DE

SMART-AG contains NovAtel’s GL1DE which is a positioning algorithms for single frequency GPS and GPS/GLONASS applications. GL1DE produces a smooth position output tuned for applications where optimal time relative (pass to pass) accuracy is more important than absolute accuracy. Because of this, it is well suited for agricultural applications.

Multipath signals tend to induce time-varying biases and increase the measurement noise on the L1 pseudorange measurements. Carrier phase measurements are much less susceptible to the effects of multipath. The GL1DE algorithm fuses the information from the L1 code and the L1 phase measurements into a Position-Time-Velocity (PVT) solution.

GL1DE includes settings for a dynamic mode, a static mode, and an “auto” mode, where the filtering parameters are automatically adjusted as vehicle velocity varies between stationary and dynamic states.

Refer to the NovAtel white papers at [www.novatel.ca/products/whitepapers.htm](http://www.novatel.ca/products/whitepapers.htm) for more information on GL1DE. Refer also to application note “APN-038 Pseudorange/Delta-Phase (PDP) and GL1DE Filters” at [www.novatel.com/support/applicationnotes.htm](http://www.novatel.com/support/applicationnotes.htm).

### 3.5 Emulated Radar (ER)

Once it is configured using the RADARCFG command (see page 78), Emulated Radar (ER) data is output through the SMART-AG cable (see Table 6 on Page 63) and the RADARSIGNAL log (see Page 82).
### 3.6 Tilt Compensation

The SMART-AG Tilt Compensation feature corrects for errors in position caused by tilting of the vehicle. The SMART-AG senses the vehicle’s roll angle and, with the user-entered “height above ground”, compensates the position output to give the position under the vehicle rather than at the antenna.

As shown in Figure 10, if an agricultural implement is operating on sloped terrain, the position will be in error by an amount proportional to the tilt angle.

![SMART-AG Tilt Compensation Diagram](image)

**Figure 10: SMART-AG Tilt Compensation**

If tilt compensation is enabled, the SMART-AG determines the tilt and corrects the position data before it is forwarded to the user equipment. In the above example, the tilt is 10 degrees, and the position correction that needs to be applied is 62 cm.

The BESTPOS, BESTXYZ and all NMEA GPGGA logs will provide tilt-compensated position logs.

Information about tilt-compensation commands can be found in Appendix B.5, $PMDT Configure Tilt Compensation starting on page 77 and information about installation and setup can be found in Chapter 2, *Installation and Setup* on page 20.
3.7 Recommended Configuration

The following command is recommended to enable CAN:

```
setcanname 305
```

The following command is recommended to enable SBAS(WAAS/EGNOS/MSAS) corrections:

```
sbascontrol enable
```

The following commands are recommended to enable GLIDE:

```
pdpfilter enable
pdpmode relative auto
```

NovAtel has registered manufactured ID code 305 with J1939. When complete, your configuration can be saved with the SAVECONFIG command. Refer to the OEMV Family Firmware Reference Manual and APN-050 SMART-AG Firmware Release for further details on these commands.
Chapter 4  PC Utilities

Visit http://www.novatel.com/support/fwswupdates.htm for the most recent versions of the PC software and receiver firmware.

4.1  CDU/Convert4 Installation

The CD accompanying this manual contains the Windows applications CDU (Control and Display Unit) and Convert4. The DL Explorer is part of CDU. They are installed via a standard Install Shield set-up application. Also included on the CD is sample source code, to aid development of software for interfacing with the receiver, and product documentation.

These applications utilize a database in their operations so the necessary components of the Borland Database Engine (BDE) are installed as well as the necessary database tables and an alias for the database. The install set-up application does all this automatically so you have only to select where you would like the applications installed on your PC. It is strongly recommended that you close all applications before installing CDU and Convert4. You must close any applications that may be using the BDE before installing. The install set-up modifies the BDE configuration so that it can recognize the new CDU and Convert4.

The software operates from your PC’s hard drive. You will need to install the software from the CD supplied by NovAtel or from our Web site:

1. Start Microsoft Windows.
2. Place the NovAtel CD in your CD-ROM drive. If the setup utility is not automatically accessible, follow these steps:
   a. Select Run from the Start menu.
   b. Select the Browse button.
   c. Locate Setup.exe on the CD drive and select Open.
   d. Select OK to run the setup utility.
3. Advance through the steps provided by the setup utility.

When the installation is complete, click on a program icon to launch the application.

※ The latest CDU is available to download from our Web site at:
   http://www.novatel.com/support/fwswupdates.htm
4.2 CDU

**CDU** is a 32-bit Windows application. The application provides a graphical user interface (GUI) to allow you to set-up and monitor the operation of the NovAtel receiver by providing a series of windows whose functionality is explained in this section. A help file is included with **CDU**. To access the file, select *Contents* from the *Help* menu.

The rest of this section shows the **CDU** windows from the *View* menu and their descriptions.

Most windows have a popup menu accessible by right clicking on the window with the mouse. They provide a way to customize the window by changing the font or to print the window contents. Some of the windows have access to the Options dialog which contains further settings for certain windows.

- **Constellation Window:** The Constellation window displays each satellite being tracked by the receiver. When you select a satellite, the window shows details of its PRN, Signal to Noise Ratio (SNR), azimuth and elevation. Concentric circles from $0^\circ$ to $90^\circ$ represent elevations from the
PC Utilities

horizon to directly overhead, respectively. The azimuth is mapped on a compass relative to true North. The colored rings indicate the lowest elevation cut-off angles at which satellites are tracked and can be changed or viewed via the button.

Each of the satellites being tracked are represented with icons according to their satellite system as follows:

• Circular for GPS
• Square for GLONASS
• Hexagon for SBAS

There are also information icons and values at the bottom of the window:

• The number of GPS/GLONASS satellites used in the solution verses the number being tracked. For example, 0/5 next to the Russian flag means that while the receiver is tracking 5 GLONASS satellites, none are currently used in the position solution.
• Satellite PRN number Azimuth and elevation angle values
• Signal to Noise Ratio (SNR) value and indicator

The PRN of the satellite is displayed on the icon and color-coding is used to indicate the status of the satellite or the tracking channel. Click on a satellite to display information on that satellite.

When a valid position has been achieved, dilution of precision (DOP) values can be viewed in the DOP window.

Open this window by selecting Constellation Window from the View menu or by clicking its button in the Window Toolbar.

• **Channel Tracking Status Window**: The Channel Tracking Status window displays key information for each of the receiver's processing channels, including the PRN of the satellite being tracked by that channel, the Signal to Noise Ratio, Pseudorange measurements, Doppler values, Residuals measurements and Lock Time from the satellite.

The TRACKSTAT log provides the data for many of the fields listed in this window. The number of channels displayed depends on the model of your receiver and the bars are color-keyed to indicate the frequency type on the channel.

Open these windows by selecting Tracking Status Window GPS/GLONASS from the View menu or by selecting the American and Russian flag buttons in the Window Toolbar.

• **Position Window**: The Position window displays:
  • The receiver's latitude, longitude and height
  • The Solution Type, also known as Position Type
  • The solution or differential age (number of seconds the current solution has been
valid). Normally this represents the latency in the correction data.

- The number of satellites used in the solution
- The Solution Status
- The receiver's date and time (GMT and local)

Open this window by selecting Position Window from the View menu or its button in the Window Toolbar.

Right-click in the Position window to that enables you to set the PC clock to the receiver's time, change the font used to display the position data or set the units through the Options dialog box.

- **Velocity Window**: The Velocity window displays vertical and horizontal speed and direction. The numeric displays within the dial, and the velocity values below the dial, show the vector velocity as well as the vertical, North, and East velocity components. If necessary, the scale in the dial increases so that you have room to accelerate.

Open this window by selecting Velocity Window from the View menu or its button in the Window Toolbar.

- **Compass Window**: The direction dial is a compass that displays the direction of motion of the receiver over ground and its elevation (both in degrees). The white arrow indicates the elevation value on the vertical scale down the centre of the dial. The black arrow on the outer rim of the dial indicates the Track Over Ground value. Both the track over ground and elevation angles are also shown at the bottom of the Compass window.

Open this window by selecting Compass Window from the View menu or its button in the Window Toolbar.

- **INS Window**: If applicable, please refer to your SPAN User Manual for more on INS. Information in the INS Position, Velocity, Attitude window is only available if you have an INS-capable receiver model.

The dial is a graphical display of the Roll, Pitch and Azimuth values indicated by an arrow on each axis.

Open this window by selecting INS Window from the View menu or its button in the Window Toolbar.

- **Plan Window**: The Plan window provides real-time graphic plotting of the current position of each connected device. The latitude and longitude shown at the bottom of the window indicate the receiver's reference position, which is used as the center of the grid system. The receiver's
subsequent positions, shown with a yellow + marker, are given relative to this initial starting point. The current position is shown with a red + marker.

The buttons at the top of the window provide options for controlling the plan display:

- Zoom in or out of the Plan window
- View all configurations or center in on the active configuration
- Select a grid or circular display
- Show/Hide history
- Delete all history (no undo)

To open this window, select Plan Window from the View menu or select its button in the Window Toolbar.

• **Doppler Window:** A value representing the uncertainty of the position solution based on the current satellite geometry. The lower the value, the greater the confidence in the solution.

In the DOP window, DOP is displayed in the following forms:

- **GDOP** Geometric DOP: Uncertainty of all parameters (latitude, longitude, height, clock offset)
- **PDOP** Position DOP: Uncertainty of the three-dimensional parameters (latitude, longitude, height)
- **HDOP** Horizontal DOP: Uncertainty of the two-dimensional parameters (latitude, longitude)
- **VDOP** Vertical DOP: Uncertainty of the height
- **TDOP** Time DOP: Uncertainty of the clock offset

• **Console Window:** This window allows the user to communicate directly to the receiver through the serial port. It is essentially a terminal emulator with added receiver functionality. Commands can be issued to the receiver via the command editor (at the bottom of the window) and sent by pressing the Enter button or simply pressing <Enter> on the keyboard. The command editor has recall functionality similar to DosKey whereby pressing the up arrow on the keyboard will move backward through the previously issued commands and pressing the down arrow will move forward through the previously issued commands. This allows the user to scroll through previously issued commands and then press the <Enter> key to issue that command again.

Feedback from the receiver is displayed in the ASCII Messages or Console window depending on the format of the message (ASCII or Abbreviated ASCII respectively).

**WARNING!:** Ensure all other windows are closed in CDU when entering the SAVECONFIG command in the Console window.
This window automatically opens when **CDU** is first connected to a receiver. To bring the window to the front, select Console Window from the View menu or click its button in the Window Toolbar.

- **Logging Control Window**: The Logging Control window provides a graphical interface for:
  - Initiating data logging to a file
  - Initiating logging to the receiver's serial ports
  - Specifying a time window for data logging
  - Stopping logging
  - Editing log settings

To display the Logging Control window, select Logging Control Window from the Tools menu or select its button in the Window Toolbar.

---

**WARNING!**: Ensure the Power Settings on your PC are not set to go into Hibernate or Standby modes. Data will be lost if one of these modes occurs during a logging session. Refer to **CDU**’s online Help for more information.

---

- **ASCII Messages Window**: This window displays ASCII formatted NovAtel logs.

To display the ASCII Messages window, select ASCII Messages Window from the View menu or select its button in the Window Toolbar.

- **Wizards**: There are two wizards available: RTK and SPAN.

  The Real Time Kinematic (RTK) wizard takes you through the steps needed to set up your RTK system. You must have an RTK-capable receiver model or the wizard does not continue past its opening page.

  The SPAN wizard takes you through the steps needed to set up your Synchronized Position Attitude Navigation (SPAN) system. You must have a SPAN-capable receiver model, or the wizard does not continue past its opening page. The SPAN wizard can help with the alignment or calibration of a SPAN system.

To display a wizard window, if you have the necessary receiver model, select SPAN Wizard or RTK Wizard from the Tools menu or select one of their buttons in the Window Toolbar.
4.3 Convert4

Convert4 is a 32-bit Windows application and is shown in Figure 11. Convert4 will accept GPS file formats and convert them to ASCII, Binary or Rinex format. The application also allows the user to screen out particular logs by selecting the desired logs from the list of available logs. This feature is useful for screening particular logs out of large data files in either ASCII or Binary formats.

![Figure 11: Convert4 Screen Examples]

4.3.1 Rinex Format

The Receiver-Independent Exchange (RINEX\(^1\)) format is a broadly-accepted, receiver-independent format for storing GPS data. It features a non-proprietary ASCII file format that can be used to combine or process data generated by receivers made by different manufacturers.

---

1. For further information on RINEX Version 2.10 file descriptions, you may wish to consult the U.S. National Geodetic Survey Web site at [http://www.ngs.noaa.gov/CORS/Rinex2.html](http://www.ngs.noaa.gov/CORS/Rinex2.html).
Chapter 4  PC Utilities

The Convert4 utility can be used to produce RINEX files from NovAtel receiver data files.

Although RINEX is intended to be a receiver-independent format, there are many optional
records and fields. Please keep this in mind when combining NovAtel and non-NovAtel
RINEX data.

When converting to RINEX, two files are produced - a RINEX observation file and a RINEX
navigation file. A third GLONASS file is produced if the data contains GLONASS observations. The
default names of these files conform to the RINEX Version 2.10 recommended naming convention of
ssssdddf.yyt, where:

- **ssss**: 4 character station name - Convert4 uses the first four characters of the `<infile>`
  parameter as the station ID
- **ddd**: day of year
- **f**: file sequence number within the day - Convert4 sets this to zero
- **t**: file type: o for the observation and n for the navigation file

Selecting the RINEX field, see Figure 11, Convert4 Screen Examples on Page 45, in the Convert4 To
section causes the:

1. *Destination File*: field to be replaced by the *Observation File*: and *Ephemeris File*: fields. Note
   that Observation File refers to the RINEX OBS file while Ephemeris File refers to the RINEX
   NAV file.
2. *RINEX Headers* buttons to appear allowing you to supply additional information that appears in
   the header records of the RINEX output files (for example, Company Name, Marker Name and
   Marker Number).

For best results, the NovAtel receiver input data file should contain the logs as in Table 5, NovAtel
Logs for Rinex Conversion on Page 47.
### Table 5: NovAtel Logs for Rinex Conversion

<table>
<thead>
<tr>
<th>NovAtel OEMV Family Log</th>
<th>Recommended Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>RANGEA/B, or RANGECMPA/B</td>
<td>ontime 15</td>
</tr>
<tr>
<td>BESTPOSA/B, or PSRPOSA/B, or RTKPOSA/B, or MARKPOSA/B</td>
<td>once</td>
</tr>
<tr>
<td>IONUTCA/B</td>
<td>unchanged</td>
</tr>
<tr>
<td>RAWEPHEMA/B</td>
<td>unchanged</td>
</tr>
<tr>
<td>GLORAWEPHEMA/B</td>
<td>unchanged</td>
</tr>
<tr>
<td>VERSIONA/B a</td>
<td>once</td>
</tr>
<tr>
<td>SITEDEFA/B b</td>
<td>once</td>
</tr>
</tbody>
</table>

a. Information from this log overrides data entered into the Receiver Number, Type and Version fields using the OBS file button of the RINEX Headers section, see Figure 11 on Page 45.

b. Available on DL-V3 receivers, refer to the DL-V3 User Manual. Information from this log overrides data entered into the Marker Name, Marker Number, Antenna Type and Antenna Delta H fields using the OBS file button of the RINEX Headers section.

### 4.3.2 Convert4 Command Line Switches

Convert4 supports several command-line switches to facilitate batch processing. To access its Command Line Arguments window, open a command prompt window (select Accessories | Command Prompt from the Start menu). Change directory (cd) to the directory on your hard drive that Convert4 is stored. Type the following: convert4 -h

The Convert4 Command Line Arguments window appears as shown in Figure 12.
The name of the output file is the same as the input file when converting to ASCII or binary formats. The file extension, however, is altered to indicate the format of the data:

- .asc for ASCII
- .bin for binary

When converting to RINEX, the output files are named according to the RINEX Version 2.10 naming convention, see Section 4.3.1, Rinex Format on Page 45.

The -batch arguments suppress the window display and convert the specified file automatically.

When converting to RINEX in batch mode, the navigation and observation file header information from the most recent interactive Convert4 session is used.

4.4 Firmware Upgrades

The receiver stores its program firmware in non-volatile memory, which allows you to perform firmware upgrades without having to return the receiver to the distributor. New firmware can be transferred to the receiver through COM1, and the unit will immediately be ready for operation at a higher level of performance.

The first step in upgrading your receiver is to contact your local NovAtel dealer. Your dealer will assist you in selecting the best upgrade option that suits your specific GPS needs. If your needs are still unresolved after seeing your dealer then you can contact NovAtel directly through any of the methods described in the Customer Service section, Page 16, at the beginning of this manual.

When you call, have your receiver model number, serial number, and program revision level available. This information can be found by issuing the LOG VERSION command at the port prompt.

After establishing which new model/revision level would best suit your needs, and having described the terms and conditions, you will be issued an authorization code (auth-code). The auth-code is required to unlock the new features according to your authorized upgrade model type.

To upgrade to a higher performance model at the same firmware revision level (for example, upgrading from a SMART-AG to a SMART-AG-ER on firmware version 3.600), you can use the AUTH command with the issued auth-code.

If you are upgrading to a higher firmware revision level (for example, upgrading a SMART-AG- PVT firmware version 3.600 to SMART-AG-RT-20 firmware version 3.710), you will need to transfer new program firmware to the OEMV family receiver using the WinLoad utility program. As WinLoad and the upgrade file are generally provided in a compressed file format, you will also be given a decompression password. WinLoad and the upgrade files can be found on NovAtel's FTP site at http://www.novatel.com, or can be sent to you by e-mail.

Your local NovAtel dealer will provide you with all the information that you require to upgrade your receiver.

4.4.1 Upgrading Using the AUTH Command

The AUTH command is a special input command which authorizes the enabling or unlocking of the
various model features. Use this command when upgrading to a higher performance OEMV family model available within the same revision level as your current model (for example, upgrading from a SMART-AG to a SMART-AG-ER on firmware version 3.600). This command only functions in conjunction with a valid auth-code assigned by Customer Service.

The upgrade can be performed directly from CDU's Command Line Screen, or from any other communications program. The procedure is as follows:

1. Power-up the OEMV family receiver and establish communications over a serial port (see Chapter 4 Operation in the OEMV Family Installation and Operation User Manual).

2. Issue the LOG VERSION command to verify the current firmware model number, revision level, and serial number.

3. Issue the AUTH command, followed by the auth-code and model type. The syntax is as follows:

   Syntax:

   `auth auth-code`

   where auth is a special command which allows program model upgrades

   auth-code is the upgrade authorization code, expressed as hhhh,hhhh,hhhh,hhhh,hhhh,model# where the h characters are an ASCII hexadecimal code, and the model# would be ASCII text

   Example:

   `auth 17cb,29af,3d74,01ec,fd34,l1smrter`

   Once the AUTH command has been executed, the OEMV family receiver will reboot itself. Issuing the LOG VERSION command will confirm the new upgrade model type and version number.

   If communicating using CDU, the communication path needs to be closed and re-opened using the Device menu.

   **4.4.2 Updating Using the WinLoad Utility**

   WinLoad is required (instead of the AUTH command) when upgrading previously released firmware with a newer version of program and model firmware (for example, upgrading a SMART-AG-PVT firmware version 3.600 to SMART-AG-RT-20 firmware version 3.700). WinLoad is a Windows utility program designed to facilitate program and model upgrades. Once WinLoad is installed and running, it will allow you to select a host PC serial port, bit rate, directory path, and file name of the new program firmware to be transferred to the OEMV family receiver via its COM1 or COM2 port. The port chosen must have an RS-232 interface to the PC.

**Transferring Firmware Files**

To proceed with your program upgrade, you must first acquire the latest firmware revision. You will need a file with a name such as OEMXXXX.EXE (where XXXX is the firmware revision level). This file is available from NovAtel's FTP site (http://www.novatel.com), or via e-mail (support@novatel.ca). If transferring is not possible, the file can be mailed to you on CD. For more information on how to contact NovAtel Customer Service please see Page 16 at the beginning of this manual.
You will need at least 1 MB of available space on your hard drive. For convenience, you may wish to copy this file to a GPS sub-directory (for example, C:\GPS\LOADER).

The file is available in a compressed format with password protection; Customer Service will provide you with the required password. After copying the file to your computer, it must be decompressed. The syntax for decompression is as follows:

Syntax:

```
[filename] [password]
```

where filename is the name of the compressed file (but not including the .EXE extension) and password is the password required to allow decompression

Example:

```
oem1001 12345678
```

A windows-based dialog box is provided for password entry.

The self-extracting archive will then generate the following files:

- **WinLoad.exe**  WinLoad utility program
- **HowTo.txt**  Instructions on how to use the WinLoad utility
- **WhatsNew.txt**  Information on the changes made in the firmware since the last revision
- **XXXX.hex**  Firmware version upgrade file, where XXXX = program version level (for example, 1001.hex)

### Using the WinLoad Utility

WinLoad is a windows based program used to download firmware to OEMV family cards. The main screen is shown in *Figure 13 on Page 50.*

![Figure 13: Main Screen of WinLoad](image)
If you are running WinLoad for the first time you will need to make sure the file and communications settings are correct.

**Open a File to Download**

From the file menu choose *Open*. Use the *Open* dialog to browse for your file, see *Figure 14, WinLoad’s Open Dialog on Page 51*.

![Figure 14: WinLoad’s Open Dialog](image)

Once you have selected your file, the name should appear in the main display area and in the title bar, see *Figure 15* below.

![Figure 15: Open File in WinLoad](image)

**Communications Settings**

To set the communications port and baud rate, select COM Settings from the Settings menu. Choose the port on your PC from the Com Port dropdown list and the baud rate from the Download Baudrate dropdown list. The baud rate should be as high as possible (the default of 115200 is preferred).
**Downloading firmware**

To download firmware follow these steps:

1. Set up the communications port as described in *Communications Settings above.*
2. Select the file to download, see *Open a File to Download on Page 51.*
3. Make sure the file path and file name are displayed in main display area, see *Figure 15, Open File in WinLoad on Page 51.*
4. Click on the Write Flash button to download the firmware.
5. Power down and then power up the receiver when “Searching for card” appears in the main display, see *Figure 17.*
6. Enter the authorization code and select OK when the Authorization Code dialog opens, see *Figure 18.*

The receiver should finish downloading and reset. The process is complete when “Done.” is displayed in the main display area, see *Figure 19.*
7. Close WinLoad.

This completes the procedure required to upgrade an OEMV family receiver.
Chapter 5  Bluetooth® Configuration

Bluetooth is a wireless radio communication standard designed for use over short ranges (within 10 m). This chapter describes how to:

- Enable Bluetooth on the SMART-AG receiver
- Set up a PC/laptop with a Bluetooth adaptor
- Locate a Bluetooth-enabled SMART-AG in range
- Communicate with the SMART-AG using Bluetooth
- Stop communicating with the SMART-AG using Bluetooth

5.1 Bluetooth on the SMART-AG Receiver

Bluetooth is automatically configured on the SMART-AG receiver’s COM3 port. Once your PC/laptop is configured for Bluetooth operation, see the next section, use HyperTerminal or CDU to communicate through COM3.

5.2 Set Up a PC/Laptop with a Bluetooth Adaptor

If your PC/laptop is already Bluetooth-equipped and ready, proceed to Section 5.3 on Page 55

1. With the PC/laptop powered on, install the driver(s) from the disc that came with your Bluetooth adapter.

2. Connect the Bluetooth adapter. An example of a D-Link USB adapter is shown in Figure 20:

Figure 20: Bluetooth Adapter for PC/Laptop

Within two minutes of connecting the USB adapter, the Bluetooth icon appears in the Windows task bar as shown in Figure 21 on page 54.

Figure 21: Bluetooth Standby: White

Continue on to the next section when you see the white Bluetooth icon. If the Bluetooth Icon is red, see Figure 22 below, then the Bluetooth installation is on your PC/laptop is incorrect and you should return to Step #1.

Figure 22: Bluetooth Error: Red
5.3 Locate a Bluetooth-Enabled SMART-AG in Range

Ensure that your PC/laptop is equipped with a built in, or external-plug-in, Bluetooth adapter and is already configured with the appropriate Bluetooth driver.

1. Power on the SMART-AG.

2. Double-click on the Bluetooth icon in the task bar, see Figure 21 on page 54, or select Programs | My Bluetooth Places from the Start menu in Windows. The My Bluetooth Places window opens.

3. Click on the Search for devices in range option from the Bluetooth Tasks side bar on the left of the My Bluetooth Places window. Bluetooth-enabled devices within range appear in the Entire Bluetooth Neighborhood folder, see Figure 23 below.

![Figure 23: My Bluetooth Places Window](image-url)
5.4 Communicate with the SMART-AG Using Bluetooth

1. Double-click the SMART-AG device icon in the Entire Bluetooth Neighborhood window, as shown in Figure 23 on page 55. The PC/laptop searches for available services. If Bluetooth is working properly, a COM port service appears.

2. Double-click the COM3 icon. To use the serial COM port, the SMART-AG must be “paired” with the PC/laptop to use the COM3 port. The Bluetooth PIN Code Request dialog appears.

3. Enter the SMART-AG default pin number of four zeroes (0000), as shown in Figure 24:

![Figure 24: Bluetooth PIN Code Request](image)

If the code is correct, a new COM dialog opens, showing the PC/laptop COM port that has been assigned to the Bluetooth link. For example, in Figure 25, the PC/laptop port is COM21.

![Figure 25: PC/Laptop COM3 Port Assignment](image)

4. Open a terminal program (HyperTerminal, for example) and configure it to the serial port specified in the Bluetooth configuration utility. In the above example, the terminal program must be configured to connect through COM21.
5. Configure the port settings as follows:
   9600 bps, no parity, 8 data bits, 1 stop bit, no handshaking, echo off

6. Through the terminal program, connect to the Bluetooth serial port, and verify the connection.

7. Type the following VERSION log request into the command prompt to ensure that the connection works:

   ...\SMART-AG User Manual Rev 4 57...

   LOG VERSION
   The Bluetooth icon in the task bar turns green when it is connected, see Figure 26 below.

   Figure 26: Bluetooth Connected: Green

5.5 Stop Communicating with the SMART-AG Using Bluetooth

1. Double-click on the Bluetooth icon in the task bar, see Figure 21 on page 54, or select Programs | My Bluetooth Places from the Start menu in Windows. The My Bluetooth Places window opens.

2. Click on the Search for devices in range option from the Bluetooth Tasks side bar on the left of the My Bluetooth Places window. Bluetooth-enabled devices within range appear in the Entire Bluetooth Neighborhood folder, see Figure 23 on page 55.

3. Double-click on the SMART-AG device icon in the Entire Bluetooth Neighborhood window, see Figure 23 on page 55. The PC/laptop searches for available services. If Bluetooth is working properly, COM port service appears.

4. Right-click on the COM3 icon and select the Disconnect Serial COM Port option. A COM3 dialog box appears, see Figure 27 on page 57, to confirm that you want to disconnect.

   Figure 27: COM3 Disconnect?

5. Click on the Yes button in the COM3 dialog and the SMART-AG’s Bluetooth is unpaired from
your PC/laptop. When the SMART-AG and PC/laptop Bluetooth are unpaired, the Bluetooth icon in the task bar appears white, see Figure 21 on page 54.
## Appendix A  Technical Specifications

### A.1 SMART-AG Receiver Performance

<table>
<thead>
<tr>
<th>PERFORMANCE</th>
<th>Channel Configuration</th>
<th>Horizontal Position Accuracy (RMS)(^b)</th>
<th>Maximum Data Rate(^e)</th>
<th>Time to First Fix</th>
<th>Signal Reacquisition</th>
<th>Time Accuracy</th>
<th>Velocity Accuracy(^b)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Autonomous</td>
<td>SBAS(^a)</td>
<td>L1 C/A Code</td>
<td>Measurements</td>
<td>Hot Start(^g)</td>
<td>L1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14 GPS L1</td>
<td>12 GLONASS L1 (optional)</td>
<td>1.2 m</td>
<td>0.8 m</td>
<td>18 cm</td>
<td>0.4 m</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 SBAS(^a)</td>
<td></td>
<td>18 cm</td>
<td>18 cm</td>
<td>23 cm</td>
<td>0.2 m</td>
</tr>
</tbody>
</table>

- **Note:** Typical values. Performance specifications subject to GPS system characteristics, US DOD operational degradation, ionospheric and tropospheric conditions, satellite geometry, baseline length, multipath effects and the presence of intentional or unintentional interference sources.

- **Note:** Export licensing restricts operation to a maximum velocity of 515 metres per second.

### Notes:

- \(^a\) Satellite Based Augmentation Systems (SBAS) include WAAS (North America), EGNOS (Europe) and MSAS (Japan).
- \(^b\) Typical values. Performance specifications subject to GPS system characteristics, US DOD operational degradation, ionospheric and tropospheric conditions, satellite geometry, baseline length, multipath effects and the presence of intentional or unintentional interference sources.
- \(^c\) Typical values with GL1DE enabled. “Pass to pass” or time relative position error is the one dimensional horizontal (cross track) position error after 15 minutes or less after an initial convergence of at least 10 minutes.
- \(^d\) Expected accuracy after convergence. RT-20 is independent of GL1DE.
- \(^e\) Model specific.
- \(^f\) Typical value. No almanac or ephemerides and no approximate position or time.
- \(^g\) Typical value. Almanac and recent ephemerides saved and approximate time entered. For more information, please refer to the “SETAPPROXTIME” command in the OEMV Family Firmware Reference Manual found on our Web site at [http://www.novatel.com/support/docupdates.htm](http://www.novatel.com/support/docupdates.htm).
### A.2 SMART-AG Specifications

**INPUT/OUTPUT CONNECTORS**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART-AG COM/PWR</td>
<td>+8 to +36 V DC at 2.5 W (typical while logging)</td>
</tr>
<tr>
<td></td>
<td>For the cable pinouts and drawings, see Section A.2.1, SMART-AG Power/Communications Development Kit Cable (01018256) starting on Page 62</td>
</tr>
<tr>
<td>Serial Com Ports</td>
<td>RS-232 F Compliant (Rx and Tx signals only)</td>
</tr>
<tr>
<td>CAN</td>
<td>SAE J1939/ ISO 11783/ ISO 11898 Compliant</td>
</tr>
<tr>
<td>Emulated Radar Output</td>
<td>High= Supply Voltage -0.5V Minimum</td>
</tr>
<tr>
<td></td>
<td>Low= 0.5V Maximum</td>
</tr>
<tr>
<td></td>
<td>Load= 3K Ohm Minimum</td>
</tr>
<tr>
<td>PPS Output</td>
<td>3.3 V CMOS Logic Compatible</td>
</tr>
<tr>
<td>MKI Input</td>
<td>3.3V CMOS Logic/ 5V Tolerant</td>
</tr>
</tbody>
</table>

**INPUT/OUTPUT CONNECTOR PROTECTION**

<table>
<thead>
<tr>
<th>Protection Type</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical Conducted/ Coupled disturbance tolerance</td>
<td>ISO 7637:2002 (Survives all pulse types)</td>
</tr>
</tbody>
</table>

**LED INDICATORS**

More details can also be found in Section 2.2.2, Status Indicators starting on Page 25

**PHYSICAL**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>155.3 x 66.8 x (\phi) 155 mm (^b)</td>
</tr>
<tr>
<td>Weight</td>
<td>495 g maximum</td>
</tr>
</tbody>
</table>

**ENVIRONMENTAL**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Temperature</td>
<td>-40°C to +75°C</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-55°C to +90°C</td>
</tr>
<tr>
<td>Humidity</td>
<td>Not to exceed 95% non-condensing</td>
</tr>
<tr>
<td>Immersion</td>
<td>MIL-STD-810F Method 512.4 Procedure 1</td>
</tr>
<tr>
<td>Vibration (^c)</td>
<td>Random MIL-STD-810F Method 514.5 C17</td>
</tr>
<tr>
<td></td>
<td>Sinusoidal IEC 68-2-6 ASAE EP455, 5.15.2 Level 1</td>
</tr>
<tr>
<td></td>
<td>Shock MIL-STD-810 F Method 516.5</td>
</tr>
</tbody>
</table>

---

\(^a\) When tracking GPS satellites.

\(^b\) \(\phi\) denotes diameter, here and in the Dimensions graphic on Page 61.

\(^c\) See also the Notice section of this manual starting on Page 13.
a. All dimension are in millimeters, please use the Unit Conversion section of the GNSS Reference Book found at http://www.novatel.com/support/docupdates.htm for conversion to other measurements.
A.2.1 SMART-AG Power/Communications Development Kit Cable (01018256)

The SMART-AG cable that accompanies the SMART-AG Development Kit, see Figure 28 below, provides a means of supplying power from a battery while operating in the field. The exposed wires (red for positive and black for negative) can then be connected to a 12 or 24V vehicular power circuit (or equivalent) protected by a 5A fast blow fuse (user supplied). The cable also has two DB-9 connectors. One can accommodate a PC/laptop serial (RS-232) communication port and the other can connect to a modem or radio transmitter to propagate differential corrections (please refer to your user-supplied modem or radio transmitter user guide for more information on its connectors).

In addition, there are a number of bare wires where the outer insulation is cut away but the wires beneath are intact. See Table 6 on Page 63 for their pinouts. For more information on mating connectors and part numbers, see Table 7 on Page 64.

This cable is RoHS compliant and its part number is 01018256.

![Figure 28: SMART-AG Development Kit Cable](image-url)
<table>
<thead>
<tr>
<th>Color</th>
<th>Signal Name</th>
<th>J1</th>
<th>J2</th>
<th>J3</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>COM1_TXD</td>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>White</td>
<td>COM1_RXD</td>
<td>2</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>COM2_TXD</td>
<td>3</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>White</td>
<td>COM2_RXD</td>
<td>4</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black</td>
<td>COM1 GND</td>
<td>5</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black</td>
<td>COM2 GND</td>
<td>5</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>White-Black</td>
<td>MKI GND</td>
<td>5</td>
<td></td>
<td></td>
<td>MKI GND</td>
</tr>
<tr>
<td>White-Black</td>
<td>ER GND</td>
<td>5</td>
<td></td>
<td></td>
<td>ER GND</td>
</tr>
<tr>
<td>White-Black</td>
<td>PPS GND</td>
<td>5</td>
<td></td>
<td></td>
<td>PULSE PER SECOND GND</td>
</tr>
<tr>
<td>Yellow</td>
<td>CANI+</td>
<td>6</td>
<td></td>
<td></td>
<td>CANI +</td>
</tr>
<tr>
<td>Green</td>
<td>CANI-</td>
<td>7</td>
<td></td>
<td></td>
<td>CANI -</td>
</tr>
<tr>
<td>-</td>
<td>RESERVED</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black</td>
<td>PWR RET (GND)</td>
<td>9</td>
<td></td>
<td></td>
<td>BATT -</td>
</tr>
<tr>
<td>Blue</td>
<td>EMULATED RADAR OUT</td>
<td>10</td>
<td></td>
<td></td>
<td>ER_OUT</td>
</tr>
<tr>
<td>White</td>
<td>EVENT MARK IN</td>
<td>11</td>
<td></td>
<td></td>
<td>MKI</td>
</tr>
<tr>
<td>Orange</td>
<td>PPS</td>
<td>12</td>
<td></td>
<td></td>
<td>PPS</td>
</tr>
<tr>
<td>-</td>
<td>RESERVED</td>
<td>13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>PWR INPUT</td>
<td>14</td>
<td></td>
<td></td>
<td>BATT +</td>
</tr>
</tbody>
</table>
A.2.2  SMART-AG Connector and Cable Requirements

Custom cables for installing your SMART-AG can be created using the following guidelines:

- Wire size: must be 0.5 mm-1.25 mm (20-16 AWG)
- Batt + connection must be protected by 5A fast blow fuse
- Serial data signals (TxD, RxD, signal ground) must be run in shielded cable. Connect shields to ground at SMART-AG end only
- CAN signal conductors must be twisted (40 twists/m, 12 twists/ft)
- Use only the recommended mating connectors listed below. Use only gold plated pins

**WARNING!**: Failure to observe the given cable construction guidelines in this section will result in damage to the wiring (not covered by warranty).

The connector used in the SMART-AG is an “AMPSEAL” dust and water sealed type produced by Tyco. The following part numbers pertain to the mating connector required to make connections to the SMART-AG. These numbers are provided for information only and are not available from NovAtel as separate parts.

**Table 7: SMART-AG Mating Connectors**

<table>
<thead>
<tr>
<th>Product</th>
<th>Part Description</th>
<th>Company</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART-AG mating connector <em>(Figure 28 on Page 62)</em></td>
<td>14-pin sealed receptacle housing-black</td>
<td>Tyco/AMP</td>
<td>776273-1</td>
</tr>
<tr>
<td>SMART-AG mating connector <em>(Figure 28 on Page 62)</em></td>
<td>14-pin sealed receptacle housing-natural</td>
<td>Tyco/AMP</td>
<td>776273-2</td>
</tr>
<tr>
<td>SMART-AG mating connector <em>(Figure 28 on Page 62)</em></td>
<td>14-pin sealed receptacle housing-grey</td>
<td>Tyco/AMP</td>
<td>776273-4</td>
</tr>
<tr>
<td>SMART-AG mating connector <em>(Figure 28 on Page 62)</em></td>
<td>14-pin sealed receptacle housing-blue</td>
<td>Tyco/AMP</td>
<td>776273-5</td>
</tr>
<tr>
<td>Gold plated pins for SMART-AG connector/loose</td>
<td>Pins, loose piece</td>
<td>Tyco/AMP</td>
<td>770854-3</td>
</tr>
<tr>
<td>Gold plated pins for SMART-AG connector/strip</td>
<td>Pins, strip (reel)</td>
<td>Tyco/AMP</td>
<td>770520-3</td>
</tr>
</tbody>
</table>

*Table 9 details the part numbers for recommended fuses and fuse holders. These numbers are provided for information only and are not available from NovAtel as separate parts.*
### Table 8: Recommended Fuse and Fuse Holders

<table>
<thead>
<tr>
<th>Fuse</th>
<th>Recommended Fuse/Fuse Holder</th>
<th>Or Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 V Fuse (standard size blade)</td>
<td>ATO Blade Fuse 5A Littelfuse 0257005</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Or Equivalent</strong></td>
<td></td>
</tr>
<tr>
<td>12 V Fuse (mini size blade)</td>
<td>Mini Blade Fuse 5A Littelfuse 0297005</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Or Equivalent</strong></td>
<td></td>
</tr>
<tr>
<td>24V Fuse (standard size blade)</td>
<td>TAC ATO Blade Fuse 5A Littelfuse 142.6185.450</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Or Equivalent</strong></td>
<td></td>
</tr>
<tr>
<td>24V Fuse (mini size blade)</td>
<td>Mini Blade Fuse 58V 5A Littelfuse 0997005</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Or Equivalent</strong></td>
<td></td>
</tr>
<tr>
<td>Fuse Holder (standard size blade)</td>
<td>In-line ATO fuse holder Littelfuse FHAC0001</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Or Equivalent</strong></td>
<td></td>
</tr>
<tr>
<td>Fuse Holder (mini size blade)</td>
<td>In-line mini fuse holder Littelfuse 0FHM0001</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Or Equivalent</strong></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B  Commands

The SMART-AG firmware implements the commands in Table 9, in addition to the OEMV family command set. The LOG command is available to all OEMV receivers but is an essential command to do any logging. It is included in this appendix for your convenience.

Table 9: SMART-AG Commands in Alphabetical Order

<table>
<thead>
<tr>
<th>ASCII Command</th>
<th>Message ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>freset</td>
<td>20</td>
<td>Factory reset (Existing OEMV Command extended to SMART-AG)</td>
</tr>
<tr>
<td>log</td>
<td>1</td>
<td>Request logs from the receiver (Existing OEMV Command extended to SMART-AG)</td>
</tr>
<tr>
<td>radarcfg</td>
<td>8192</td>
<td>Configure the ER signal output (New SMART-AG command)</td>
</tr>
<tr>
<td>reset</td>
<td>18</td>
<td>Perform a hardware reset (Existing OEMV Command extended to SMART-AG)</td>
</tr>
</tbody>
</table>

The arguments for each of these commands are described in the following sections.

For a complete listing and description of the other commands that the SMART-AG, an OEMV-1G-based receiver, is capable of processing, refer to the OEMV Family Firmware Reference Manual.

B.1 SYNTAX CONVENTIONS

The following rules apply when entering commands, at the command prompt, from a keyboard.

1. Courier font is used to illustrate program output or user input.
2. References to other commands, logs or any of their fields are shown in *italics*.
3. The commands are not case sensitive. For example, you could type either RESET or reset.
4. Except where noted, either a space or a comma can separate commands and their required entries. For example, you could type either fix position 51.11358042, -114.04358013, 1059.4105 or fix position 51.11358042, -114.04358013, 1059.4105.
5. At the end of a command, a carriage return is required. For example, press <Enter> or <Return> on your keyboard.
6. Responses are provided to indicate whether or not an entered command was accepted. The format of the response depends on the format of the command. Refer to the OEMV Family Firmware Reference Manual for more information.
7. Optional parameters are indicated by square brackets ([ ]). For commands that contain optional parameters, the value used if the optional parameter is not specified is given in the syntax table for the command.
8. Data format definitions, as specified in the “Format” field, are detailed in the OEMV Family Firmware Reference Manual. Note that all binary data is little-endian byte-ordered.
B.2 COM Configure COM Port

This command permits you to configure the receiver’s asynchronous serial port communications drivers.

The current COM port configuration can be reset to its default state at any time by sending it two hardware break signals of 250 milliseconds each, spaced by fifteen hundred milliseconds (1.5 seconds) with a pause of at least 250 milliseconds following the second break. This will:

- Stop the logging of data on the current port (see UNLOGALL command in the OEMV Family Firmware Reference Manual).
- Clear the transmit and receive buffers on the current port.
- Return the current port to its default settings (see Factory Defaults section in Chapter 2 Commands of the OEMV Family Firmware Reference Manual).
- Set the interface mode to NovAtel for both input and output (see INTERFACEMODE command in the OEMV Family Firmware Reference Manual).

⚠️ Baud rates higher than 115,200 bps are not supported by standard PC hardware. Special PC hardware may be required for higher rates, including 230400 bps, 460800 bps and 921600 bps. Also, some PC's have trouble with baud rates beyond 57600 bps.

Abbreviated ASCII Syntax: Message ID: 4

COM [port] bps [parity[databits[stopbits[handshake[echo[break]]]]]]

Factory Default:

com com1 9600 n 8 1 n off on
com com2 9600 n 8 1 n off on
com com3 9600 n 8 1 n off on
com aux 9600 n 8 1 n off on

ASCII Example:

com com1,57600,n,8,1,n,off,on

⚠️ Watch for situations where the COM ports of two receivers are connected together and the baud rates do not match. Data transmitted through a port operating at a slower baud rate may be misinterpreted as break signals by the receiving port if it is operating at a higher baud rate. This is because data transmitted at the lower baud rate is stretched relative to the higher baud rate. In this case, configure the receiving port to have break detection disabled using the COM command.

WARNING!: Use the COM command before using the INTERFACEMODE command on each port. Turn break detection off using the COM command to stop the port from resetting because it is interpreting incoming bits as a break command.
### Table 10: COM Serial Port Identifiers

<table>
<thead>
<tr>
<th>Binary</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM1</td>
<td>COM port 1</td>
</tr>
<tr>
<td>2</td>
<td>COM2</td>
<td>COM port 2</td>
</tr>
<tr>
<td>3</td>
<td>COM3</td>
<td>COM port 3</td>
</tr>
<tr>
<td>6</td>
<td>THISPORT</td>
<td>The current COM port</td>
</tr>
<tr>
<td>8</td>
<td>ALL</td>
<td>All COM ports</td>
</tr>
<tr>
<td>9</td>
<td>XCOM1 a</td>
<td>Virtual COM1 port</td>
</tr>
<tr>
<td>10</td>
<td>XCOM2 a</td>
<td>Virtual COM2 port</td>
</tr>
<tr>
<td>13</td>
<td>USB1 b</td>
<td>USB port 1</td>
</tr>
<tr>
<td>14</td>
<td>USB2 b</td>
<td>USB port 2</td>
</tr>
<tr>
<td>15</td>
<td>USB3 b</td>
<td>USB port 3</td>
</tr>
<tr>
<td>16</td>
<td>AUX</td>
<td>AUX port</td>
</tr>
<tr>
<td>17</td>
<td>XCOM3 a</td>
<td>Virtual COM3 port</td>
</tr>
</tbody>
</table>

a. The XCOM1, XCOM2 and XCOM3 identifiers are not available with the COM command but may be used with other commands.

b. The only other field that applies when a USB port is selected is the echo field. A placeholder must be inserted for all other fields to use the echo field in this case.

### Table 11: Parity

<table>
<thead>
<tr>
<th>Binary</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>N</td>
<td>No parity (default)</td>
</tr>
<tr>
<td>1</td>
<td>E</td>
<td>Even parity</td>
</tr>
<tr>
<td>2</td>
<td>O</td>
<td>Odd parity</td>
</tr>
</tbody>
</table>

### Table 12: Handshaking

<table>
<thead>
<tr>
<th>Binary</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>N</td>
<td>No handshaking (default)</td>
</tr>
<tr>
<td>1</td>
<td>XON</td>
<td>XON/XOFF software handshaking</td>
</tr>
<tr>
<td>2</td>
<td>CTS</td>
<td>CTS/RTS hardware handshaking</td>
</tr>
<tr>
<td>Field</td>
<td>Field Type</td>
<td>ASCII Value</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1</td>
<td>COM header</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>port</td>
<td>See Table 10, COM Serial Port Identifiers on Page 68</td>
</tr>
<tr>
<td>3</td>
<td>bps/baud</td>
<td>300, 600, 900, 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200, or 230400</td>
</tr>
<tr>
<td>4</td>
<td>parity</td>
<td>See Table 11 on Page 68</td>
</tr>
<tr>
<td>5</td>
<td>databits</td>
<td>7 or 8</td>
</tr>
<tr>
<td>6</td>
<td>stopbits</td>
<td>1 or 2</td>
</tr>
<tr>
<td>7</td>
<td>handshake</td>
<td>See Table 12 on Page 68</td>
</tr>
<tr>
<td>8</td>
<td>echo</td>
<td>OFF 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ON 1</td>
</tr>
<tr>
<td>9</td>
<td>break</td>
<td>OFF 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ON 1</td>
</tr>
</tbody>
</table>
B.3 FRESET Clear Selected Data from NVM and Reset

The OEMV *freset* command is extended to include SMART-AG features. An additional target field, *userdata* (value = 10), resets only the SMART-AG user data NVM, thereby resetting all parameters indicated in this document as “Stored in NVM” to factory defaults. Issuing the *freset* command with the “target” field set to *standard*, resets the userdata NVM as well as OEMV parameters as indicated in the *OEMV Family Firmware Reference Manual*.

Issuing the FRESET command affects Tilt as follows:

- Tilt sensor level is restored to the factory default
- Tilt enable/disable will not be affected

If you issue the FRESET command without any parameters, it is the same as issuing a FRESET STANDARD command.

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Type</th>
<th>ASCII Value</th>
<th>Binary Value</th>
<th>Description</th>
<th>Binary Format</th>
<th>Binary Bytes</th>
<th>Binary Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FRESET header</td>
<td>-</td>
<td>-</td>
<td>This field contains the command name or the message header depending on whether the command is abbreviated ASCII, ASCII or binary, respectively.</td>
<td>-</td>
<td>H</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>target</td>
<td>See Table 13</td>
<td>Data to be reset by the receiver</td>
<td>Enum</td>
<td>4</td>
<td>H</td>
<td></td>
</tr>
</tbody>
</table>

**Table 13: FRESET Target**

<table>
<thead>
<tr>
<th>Binary</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>STANDARD</td>
<td>Resets commands, ephemeris, and almanac (default). Also resets all L-band related data except for subscription information.</td>
</tr>
<tr>
<td>1</td>
<td>COMMAND</td>
<td>Resets the stored commands (saved configuration)</td>
</tr>
<tr>
<td>2</td>
<td>GPSALMANAC</td>
<td>Resets the stored GPS almanac</td>
</tr>
<tr>
<td>3</td>
<td>GPSEPHEM</td>
<td>Resets the stored GPS ephemeris</td>
</tr>
<tr>
<td>4</td>
<td>GLOEPHEM</td>
<td>Resets the stored GLONASS ephemeris</td>
</tr>
<tr>
<td>5</td>
<td>MODEL</td>
<td>Resets the currently selected model</td>
</tr>
<tr>
<td>10</td>
<td>USERDATA</td>
<td>Reset SMART-AG-only commands</td>
</tr>
</tbody>
</table>

Continued on the following page
<table>
<thead>
<tr>
<th>Binary</th>
<th>ASCII</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>CLKCALIBRATION</td>
<td>Resets the parameters entered using the CLOCKCALIBRATE</td>
</tr>
<tr>
<td>20</td>
<td>SBASALMANAC</td>
<td>Resets the stored SBAS almanac</td>
</tr>
<tr>
<td>21</td>
<td>LAST_POSITION</td>
<td>Resets the position using the last stored position</td>
</tr>
<tr>
<td>31</td>
<td>GLOALMANAC</td>
<td>Resets the stored GLONASS almanac</td>
</tr>
</tbody>
</table>
B.4 LOG Request Logs from the Receiver

Many different types of data can be logged using several different methods of triggering the log events. Every log element can be directed to any combination of the three COM ports and three USB ports. The ONTIME trigger option requires the addition of the \textit{period} parameter. See the \textit{OEMV Family Firmware Reference Manual} and the \textit{SMART-AG Firmware Reference Manual} for further information and a complete list of data log structures. The \textit{LOG} command tables in this section show the ASCII command format.

The optional parameter \([\text{hold}]\) prevents a log from being removed when the UNLOGALL command, with its defaults, is issued. To remove a log which was invoked using the \([\text{hold}]\) parameter requires the specific use of the UNLOG command. To remove all logs that have the \([\text{hold}]\) parameter, use the UNLOGALL command with the \textit{held} field set to 1.

The \([\text{port}]\) parameter is optional. If \([\text{port}]\) is not specified, \([\text{port}]\) is defaulted to the port that the command was received on.

* 1. The OEMV family of receivers can handle 30 logs at a time. If you attempt to log more than 30 logs at a time, the receiver responds with an Insufficient Resources error. Each COM port (serial and USB) already has RXSTATUSEVENT log associated with it. This means that with 3 serial ports and no USB ports, 7 logs are already accounted for, as shown below:

- RXSTATUSEVENT on COM1, COM2, and COM3
- TRACKSTAT, BESTVEL, TILTDATA and PSRXYZ on XCOM1

See the example on the next page.

2. Maximum flexibility for logging data is provided to the user by these logs. The user is cautioned, however, to recognize that each log requested requires additional CPU time and memory buffer space. Too many logs may result in lost data and degraded CPU performance. Receiver overload can be monitored using the idle-time field and buffer overload bits of the Receiver Status in any log header.

3. Polled log types do not allow fractional offsets or ONTIME rates faster than 1Hz.

4. Use the ONNEW trigger with the MARKTIME, MARK2TIME, MARKPOS or MARK2POS logs.

5. Only the MARKPOS, MARK2POS, MARKTIME or MARK2TIME logs, and ‘polled’ log types are generated ‘on the fly’ at the exact time of the mark. Synchronous and asynchronous logs output the most recently available data.

6. If you do use the ONTIME trigger with asynchronous logs, the time stamp in the log does not necessarily represent the time the data was generated, but rather the time when the log is being transmitted.
Abbreviated ASCII Syntax:  
LOG [port] message [trigger [period [offset [hold]]]]

Factory Default:

log com1 rxstatuseventa onnew 0 0 hold  
log com2 rxstatuseventa onnew 0 0 hold  
log com3 rxstatuseventa onnew 0 0 hold  
log aux rxstatuseventa onnew 0 0 hold  
log usb1 rxstatuseventa onnew 0 0 hold  
log usb2 rxstatuseventa onnew 0 0 hold  
log usb3 rxstatuseventa onnew 0 0 hold

Abbreviated ASCII Example 1:

log com1 bestpos ontime 7 0.5 hold

The above example shows BESTPOS logging to COM port 1 at 7 second intervals and offset by 0.5 seconds (output at 0.5, 7.5, 14.5 seconds and so on). The [hold] parameter is set so that logging is not disrupted by the UNLOGALL command.

To send a log only one time, the trigger option can be ignored.

Abbreviated ASCII Example 2:

log com1 bestpos once 0.000000 0.000000 nohold

Refer to the Command Formats section of the OEMV Family Firmware Reference Manual for additional examples.

* 1. In CDU there are two ways to initiate data logging to the receiver's serial ports. You can either enter the LOG command in the Console window, or use the interface provided in the Logging Control window. Ensure the Power Settings on your PC are not set to go into Hibernate or Standby modes. Data is lost if one of these modes occurs during a logging session.

2. Only the ASCII/Abbreviated ASCII log table is included in this manual. Please refer to the LOG command in the OEMV Family Firmware Reference Manual for binary log details.
<table>
<thead>
<tr>
<th>Field</th>
<th>Field Name</th>
<th>ASCII Value</th>
<th>Description</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LOG (ASCII) header</td>
<td>-</td>
<td>This field contains the command name or the message header depending on whether the command is abbreviated ASCII or ASCII respectively.</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>port</td>
<td>See Table 14, Detailed Serial Port Identifiers on Page 75</td>
<td>Output port (default = THISPORT)</td>
<td>Enum</td>
</tr>
<tr>
<td>3</td>
<td>message</td>
<td>Any valid message name, with an optional A or B suffix.</td>
<td>Message name of log to output</td>
<td>Char [ ]</td>
</tr>
<tr>
<td>4</td>
<td>trigger</td>
<td>ONNEW</td>
<td>Output when the message is updated (not necessarily changed)</td>
<td>Enum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ONCHANGED</td>
<td>Output when the message is changed</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ONTIME</td>
<td>Output on a time interval</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ONNEXT</td>
<td>Output only the next message</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ONCE</td>
<td>Output only the current message. (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ONMARK</td>
<td>Output when a pulse is detected on the mark 1 input, MK1I</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>period</td>
<td>Any positive double value larger than the receiver’s minimum raw measurement period</td>
<td>Log period (for ONTIME trigger) in seconds (default = 0)</td>
<td>Double</td>
</tr>
<tr>
<td>6</td>
<td>offset</td>
<td>Any positive double value smaller than the period.</td>
<td>Offset for period (ONTIME trigger) in seconds. If you wished to log data at 1 second after every minute you would set the period to 60 and the offset to 1 (default = 0)</td>
<td>Double</td>
</tr>
<tr>
<td>7</td>
<td>hold</td>
<td>NOHOLD</td>
<td>Allow log to be removed by the UNLOGALL command (default)</td>
<td>Enum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HOLD</td>
<td>Prevent log from being removed by the UNLOGALL command</td>
<td></td>
</tr>
</tbody>
</table>
### Table 14: Detailed Serial Port Identifiers

<table>
<thead>
<tr>
<th>ASCII Port Name</th>
<th>Hex Port Value</th>
<th>Decimal Port Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO_PORTS</td>
<td>0</td>
<td>0</td>
<td>No ports specified</td>
</tr>
<tr>
<td>COM1_ALL</td>
<td>1</td>
<td>1</td>
<td>All virtual ports for COM port 1</td>
</tr>
<tr>
<td>COM2_ALL</td>
<td>2</td>
<td>2</td>
<td>All virtual ports for COM port 2</td>
</tr>
<tr>
<td>COM3_ALL</td>
<td>3</td>
<td>3</td>
<td>All virtual ports for COM port 3</td>
</tr>
<tr>
<td>THISPORT_ALL</td>
<td>6</td>
<td>6</td>
<td>All virtual ports for the current port</td>
</tr>
<tr>
<td>ALL_PORTS</td>
<td>8</td>
<td>8</td>
<td>All virtual ports for all ports</td>
</tr>
<tr>
<td>XCOM1_ALL</td>
<td>9</td>
<td>9</td>
<td>All virtual COM1 ports</td>
</tr>
<tr>
<td>XCOM2_ALL</td>
<td>10</td>
<td>10</td>
<td>All virtual COM2 ports</td>
</tr>
<tr>
<td>USB1_ALL</td>
<td>d</td>
<td>13</td>
<td>All virtual ports for USB port 1</td>
</tr>
<tr>
<td>USB2_ALL</td>
<td>e</td>
<td>14</td>
<td>All virtual ports for USB port 2</td>
</tr>
<tr>
<td>USB3_ALL</td>
<td>f</td>
<td>15</td>
<td>All virtual ports for USB port 3</td>
</tr>
</tbody>
</table>
| AUX_ALL         | 10             | 16                 | All virtual ports for the AUX port  
| XCOM3_ALL       | 11             | 17                 | All virtual COM3 ports |
| COM1            | 20             | 32                 | COM port 1, virtual port 0 |
| COM1_1          | 21             | 33                 | COM port 1, virtual port 1 |
| ...             |                |                    |             |
| COM1_31         | 3f             | 63                 | COM port 1, virtual port 31 |
| COM2            | 40             | 64                 | COM port 2, virtual port 0 |
| ...             |                |                    |             |
| COM2_31         | 5f             | 95                 | COM port 2, virtual port 31 |
| COM3            | 60             | 96                 | COM port 3, virtual port 0 |
| ...             |                |                    |             |
| COM3_31         | 7f             | 127                | COM port 3, virtual port 31 |
| USB             | 80             | 128                | USB port, virtual port 0 |
| ...             |                |                    |             |
| USB_31          | 9f             | 159                | USB port, virtual port 31 |
| SPECIAL         | a0             | 160                | Unknown port, virtual port 0 |
| ...             |                |                    |             |
| SPECIAL_31      | bf             | 191                | Unknown port, virtual port 31 |
| THISPORT        | c0             | 192                | Current COM port, virtual port 0 |

*Continued on the following page*
<table>
<thead>
<tr>
<th>ASCII Port Name</th>
<th>Hex Port Value</th>
<th>Decimal Port Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>THISPORT_31</td>
<td>df</td>
<td>223</td>
<td>Current COM port, virtual port 31</td>
</tr>
</tbody>
</table>
| FILE            | e0             | 224               | User-specified file destination, 0  
| FILE_1          | e1             | 225               | User-specified file destination, 1  
|                 | ...            |                   |             |
| FILE_31         | ff             | 255               | User-specified file destination, 31 |
| XCOM1           | 1a0            | 416               | Virtual COM1 port, virtual port 0 |
| XCOM1_1         | 1a1            | 417               | Virtual COM1 port, virtual port 1 |
|                 | ...            |                   |             |
| XCOM1_31        | 1bf            | 447               | Virtual COM1 port, virtual port 31 |
| XCOM2           | 2a0            | 672               | Virtual COM2 port, virtual port 0 |
| XCOM2_1         | 2a1            | 673               | Virtual COM2 port, virtual port 1 |
|                 | ...            |                   |             |
| XCOM2_31        | 2bf            | 703               | Virtual COM2 port, virtual port 31 |
| USB1            | 5a0            | 1440              | USB port 1, virtual port 0 |
| USB1_1          | 5a1            | 1441              | USB port 1, virtual port 1 |
|                 | ...            |                   |             |
| USB1_31         | 5bf            | 1471              | USB port 1, virtual port 31 |
| USB2            | 6a0            | 1696              | USB port 2, virtual port 0 |
|                 | ...            |                   |             |
| USB2_31         | 6bf            | 1727              | USB port 2, virtual port 31 |
| USB3            | 7a0            | 1952              | USB port 3, virtual port 0 |
|                 | ...            |                   |             |
| USB3_31         | 7bf            | 1983              | USB port 3, virtual port 31 |
| AUX             | 8a0            | 2208              | AUX port, virtual port 0  
|                 | ...            |                   |             |
| AUX_31          | 8bf            | 2239              | AUX port, virtual port 31  
| XCOM3           | 9a0            | 2464              | Virtual COM3 port, virtual port 0 |
|                 | ...            |                   |             |
| XCOM3_31        | 9bf            | 2495              | Virtual COM3 port, virtual port 31 |

a. Decimal port values 0 through 16 are only available to the UNLOGALL command and cannot be used in the UNLOG command, or in the binary message header.

b. The AUX port is available on OEMV-2-based and OEMV-3-based products.

c. SMART-AG only. Refer to the SMART-AG Firmware Reference Manual and CDU’s Help file.
B.5  $PMDT Configure Tilt Compensation

Use this command to configure the Tilt Compensation function.

Syntax

$PMDT,[command],[parameters]*cksum

<table>
<thead>
<tr>
<th>Host</th>
<th>Description</th>
<th>Command Format</th>
<th>Tilt Sensor Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>l</td>
<td>Set Field Level</td>
<td>$PMDT,l,*cksum crlf</td>
<td>Response to the “l” command: $PMDT,&lt;,Level state set crlf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: $PMDT,l*4D</td>
<td>Example: $PMDT,&lt;,Level state set</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>u</td>
<td>Set GPS Sensor Height</td>
<td>To set the GPS sensor height in feet and inches: $PMDT,u,,ff,ii,*cksum crlf</td>
<td>Response to the “u” command: $PMDT,&lt;,GPS sensor height (inches):nnnnn crlf</td>
</tr>
<tr>
<td>a</td>
<td></td>
<td>Example: To set the GPS sensor height to 12 ft 6 in, the command is: $PMDT,u,,12,6*4D</td>
<td>where nnnnn is a five digit integer, sensor height in inches. In this example, the Tilt Sensor response is: $PMDT,&lt;,GPS sensor height (inches): 00150</td>
</tr>
<tr>
<td>b</td>
<td></td>
<td>Note: Feet and inches are entered as integers, You can enter feet and inches, but not feet, inches and metres.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To set the GPS sensor height in metres: $PMDT,u,,,,mmm.mmm *cksum crlf</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: To set the GPS sensor height to 3.5 metres, the command is: $PMDT,u,,,,3.5*5C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>Update Flash Values</td>
<td>To update flash values (needs to follow any height or level command that is not done each time you power up): $PMDT,x,*cksum crlf</td>
<td>Response to the “x” command: $PMDT,&lt;,Flash updated crlf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: $PMDT,x,*59</td>
<td>Example: $PMDT,&lt;,Flash updated</td>
</tr>
</tbody>
</table>

a. If all fields in the u command are zero or null, the current height is transmitted without change (with the format shown above).

b. If an invalid entry is received (>500 inches), the response is:

$PMDT,<Max legal height exceeded: nnnnn and will be ignored crlf

For example, if you enter 42 ft 6 in, you will get the following response:

$PMDT,<,Max legal height exceeded: 00510 and will be ignored
$PMDT,<,GPS sensor height (inches): 00150
B.6 RADARCFG Configure the ER Output

Use this command to configure the Emulated Radar (ER) output. ER is available through the SMART-AG multi-cable, see Page 63 for pin-out details.

Syntax

```
radarcfg switch freq_step update_rate resp_mode threshold
```

Message ID = 8192

<table>
<thead>
<tr>
<th>Field</th>
<th>Data</th>
<th>Description</th>
<th>Bytes</th>
<th>Format</th>
<th>Units</th>
<th>Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Header</td>
<td>This field contains the command name or the message header depending on whether the command is abbreviated ASCII, ASCII or binary, respectively.</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>0</td>
</tr>
</tbody>
</table>
| 2     | switch | Enable or disable radar emulation
0 = ENABLE
1 = DISABLE
(default = enable) | 4 | Enum | none | H |
| 3     | freq_step | Frequency step per kilometer per hour.
Range: 26.11, 28.12 or 36.11
(default = 36.11) | 8 | Double | Hz/ kph | H+4 |
| 4     | update_rate | Specify how often to update radar output
Range: 1, 2, 5, 10, 20
(default = 10)a | 4 | Integer | Hz | H+12 |
| 5     | resp_mode | Specify the time, response mode, over which to average velocity samples, see Table 15.
(Default = 500)a | 4 | Integer | none | H+16 |
| 6     | threshold | The threshold is only applicable when the response mode is set to 2. The response time is 1000 ms when the velocity is greater than this value, otherwise, it is 500 ms. Range: 2-50 kph (default = 5 kph) | 8 | Double | kph | H+20 |

a. The number of samples used for smoothing depends on both the update_rate and resp_mode parameters. For instance, if the update_rate is 5 Hz and the resp_mode is 2000ms, the number of samples used will be 10.
Table 15: Response Modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>2000 ms</td>
</tr>
<tr>
<td>1000</td>
<td>1000 ms</td>
</tr>
<tr>
<td>500</td>
<td>500 ms (default)</td>
</tr>
<tr>
<td>2</td>
<td>Automatically switches between 1000 and 500 ms</td>
</tr>
<tr>
<td>1</td>
<td>Performs no smoothing</td>
</tr>
</tbody>
</table>

Example 1 to disable radar emulation:  
radarcfg disable 26.11 1 1 2

Example 2 to set the frequency step to 36.11 Hz/kph, update rate to 1 Hz and no smoothing:  
radarcfg enable 36.11 1 1 2
Appendix C  Logs

C.1 Position Logs

C.1.1 NMEA Logs

The NMEA logs (receiver outputs) supported by the SMART-AG are summarized in Chapter 3 of the OEMV Family Firmware Reference Manual in section "NMEA Standard Logs". The available logs include:

- **GPGGA**, which outputs a log of position system fix data and undulation. There are variants of GPGGA, specifically:
  - **GPGGARTK**, which has greater precision than GPGGA but with the loss of the undulation field
  - **GPGGALONG**, which has both greater precision and the undulation field
- **GPVTG**, which outputs track made good and ground speed

Each of the available NMEA standard logs is described in more detail in its own section of Chapter 3 of the OEMV Family Firmware Reference Manual.

The steps for configuring the receiver output, through the command line are:

1. Configure the communication port using the COM command, described in Appendix B.2, COM Configure COM Port on Page 67. To set COM port 2 as follows:

<table>
<thead>
<tr>
<th>Bit Rate</th>
<th>9600</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parity</td>
<td>none</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Handshaking</td>
<td>None</td>
</tr>
<tr>
<td>Echo</td>
<td>Off</td>
</tr>
<tr>
<td>Break</td>
<td>On</td>
</tr>
</tbody>
</table>

   enter the following string:

   ```
   com com2 9600 n 8 1 n off on
   ```

2. Select and configure the NMEA string that you want to output. The information is described in Chapter 3 Data Logs of the OEMV Family Firmware Reference Manual, in the section for the particular log. For example, to log gpgga (position system fix data and undulation) at 2 Hz, enter the following string:

   ```
   log gpgga ontime 0.5
   ```
You can configure the log to output at various frequencies, as described in Appendix B.4, LOG Request Logs from the Receiver on Page 72.

The above command line operations can also be carried out through the CDU. Information about configuring the communication port can be found in the CDU online help in Contents > Getting Started > Connecting to the receiver. Information about logging data can be found in Getting Started > Logging Data. The procedure for adding a NMEA log through the CDU is summarized as follows:

1. In the **Logging control** window, click *Logging to one or more of the receiver's serial ports*. The **Add Log** window displays.

2. Beside **Select list**, select *Complete List* or *NMEA List*.

3. Beside **Log to file**, select the NMEA log you want to add.

4. Select the port.

5. Configure the remaining fields then click *Add*.

### C.1.2 NovAtel Position Logs

In addition to NMEA logs, NovAtel supports a range of non-NMEA position logs, described in the *OEMV Family Firmware Reference Manual*, including:

- **BESTPOS**: This log contains the best available combined GPS and interial navigation system (INS, if available) position computed by the receiver, for example:
  
  `log bestposa ontime 0.5`

- **BESTXYZ**: This log contains the receiver’s best available position and velocity in ECEF coordinates, for example:
  
  `log bestxyza ontime 1`
C.2 Other Logs

The SMART-AG firmware generates the logs in Table 16, in addition to those of the OEMV Family log set. Refer to the OEMV Family Firmware Reference Manual, which also contains procedures and explanations related to data logging and is available from our Web site at:

http://www.novatel.com/support/docupdates.htm

Table 16: SMART-AG Logs in Alphabetical Order

<table>
<thead>
<tr>
<th>Message ID</th>
<th>ASCII Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8193</td>
<td>RADARSIGNAL</td>
<td>Radar signal and position information (New SMART-AG log)</td>
</tr>
<tr>
<td>37</td>
<td>VERSION</td>
<td>Hardware versions, software versions, and serial numbers (Existing OEMV log extended to SMART-AG)</td>
</tr>
</tbody>
</table>

C.2.1 RADARSIGNAL ER Signal and Position Information

This log contains position and Emulated Radar (ER) signal information.

Message ID: 8193
Log Type: Asynch

Recommended Input:

log radarsignala onchanged

ASCII Example 1 (stationary SMART-AG):

#RADARSIGNALA,COM1,0,61.5,FINESTEERING,1501,248381.628,00000000,8a1c,3723;
SOL_COMPUTED,WAAS,0.0139,0.00,0.00*f0d580ca

ASCII Example 2 (moving SMART-AG):

#RADARSIGNALA,COM1,0,42.5,FINESTEERING,1428,206179.600,00000000,baa8,3349;
SOL_COMPUTED,WAAS,0.3315,2,0.3152,473.97,29.62*c1479c20
<table>
<thead>
<tr>
<th>Field #</th>
<th>Field type</th>
<th>Data Description</th>
<th>Format</th>
<th>Binary Bytes</th>
<th>Binary Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RADAR-SIGNAL header</td>
<td>Log header</td>
<td></td>
<td>H</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>sol status</td>
<td>Solution status, see <em>Table 18, Solution Status on Page 85</em></td>
<td>Enum</td>
<td>4</td>
<td>H</td>
</tr>
<tr>
<td>3</td>
<td>vel type</td>
<td>Velocity type, see <em>Table 17, Position or Velocity Type on Page 84</em></td>
<td>Enum</td>
<td>4</td>
<td>H+4</td>
</tr>
<tr>
<td>4</td>
<td>speed</td>
<td>Speed over ground (m/s)</td>
<td>Double</td>
<td>8</td>
<td>H+8</td>
</tr>
<tr>
<td>4</td>
<td>varf freq</td>
<td>External VARF output frequency (Hz)</td>
<td>Double</td>
<td>8</td>
<td>H+16</td>
</tr>
<tr>
<td>5</td>
<td>radar freq</td>
<td>Radar signal frequency (Hz) as output by the Emulated Radar Out signal. See <em>SMART-AG Development Kit Cable starting on Page 62.</em></td>
<td>Double</td>
<td>8</td>
<td>H+24</td>
</tr>
<tr>
<td>6</td>
<td>xxxx</td>
<td>32-bit CRC (ASCII and Binary only)</td>
<td>Hex</td>
<td>4</td>
<td>H+32</td>
</tr>
<tr>
<td>7</td>
<td>[CR][LF]</td>
<td>Sentence terminator (ASCII only)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### Table 17: Position or Velocity Type

<table>
<thead>
<tr>
<th>Type (binary)</th>
<th>Type (ASCII)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>NONE</td>
<td>No solution</td>
</tr>
<tr>
<td>1</td>
<td>FIXEDPOS</td>
<td>Position has been fixed by the FIX POSITION command</td>
</tr>
<tr>
<td>2</td>
<td>FIXEDHEIGHT</td>
<td>Position has been fixed by the FIX HEIGHT/AUTO command</td>
</tr>
<tr>
<td>8</td>
<td>DOPPLER_VELOCITY</td>
<td>Velocity computed using instantaneous Doppler</td>
</tr>
<tr>
<td>16</td>
<td>SINGLE</td>
<td>Single point position</td>
</tr>
<tr>
<td>17</td>
<td>PSRDIFF</td>
<td>Pseudorange differential solution</td>
</tr>
<tr>
<td>18</td>
<td>WAAS</td>
<td>Solution calculated using corrections from an SBAS</td>
</tr>
<tr>
<td>19</td>
<td>PROPAGATED</td>
<td>Propagated by a Kalman filter without new observations</td>
</tr>
<tr>
<td>32</td>
<td>L1_FLOAT</td>
<td>Floating L1 ambiguity solution</td>
</tr>
<tr>
<td>33</td>
<td>IONOFREE_FLOAT</td>
<td>Floating ionospheric-free ambiguity solution</td>
</tr>
<tr>
<td>34</td>
<td>NARROW_FLOAT</td>
<td>Floating narrow-lane ambiguity solution</td>
</tr>
<tr>
<td>48</td>
<td>L1_INT</td>
<td>Integer L1 ambiguity solution</td>
</tr>
<tr>
<td>49</td>
<td>WIDE_INT</td>
<td>Integer wide-lane ambiguity solution</td>
</tr>
<tr>
<td>50</td>
<td>NARROW_INT</td>
<td>Integer narrow-lane ambiguity solution</td>
</tr>
</tbody>
</table>
### Table 18: Solution Status

<table>
<thead>
<tr>
<th>Solution Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 SOL_COMPUTED</td>
<td>Solution computed</td>
</tr>
<tr>
<td>1 INSUFFICIENT_OBS</td>
<td>Insufficient observations</td>
</tr>
<tr>
<td>2 NO_CONVERGENCE</td>
<td>No convergence</td>
</tr>
<tr>
<td>3 SINGULARITY</td>
<td>Singularity at parameters matrix</td>
</tr>
<tr>
<td>4 COV_TRACE</td>
<td>Covariance trace exceeds maximum (trace &gt; 1000 m)</td>
</tr>
<tr>
<td>5 TEST_DIST</td>
<td>Test distance exceeded (maximum of 3 rejections if distance &gt; 10 km)</td>
</tr>
<tr>
<td>6 COLD_START</td>
<td>Not yet converged from cold start</td>
</tr>
<tr>
<td>7 V_H_LIMIT</td>
<td>Height or velocity limits exceeded (in accordance with export licensing restrictions)</td>
</tr>
<tr>
<td>8 VARIANCE</td>
<td>Variance exceeds limits</td>
</tr>
<tr>
<td>9 RESIDUALS</td>
<td>Residuals are too large</td>
</tr>
<tr>
<td>10 DELTA_POS</td>
<td>Delta position is too large</td>
</tr>
<tr>
<td>11 NEGATIVE_VAR</td>
<td>Negative variance</td>
</tr>
<tr>
<td>12 Reserved</td>
<td></td>
</tr>
<tr>
<td>13 INTEGRITY_WARNING</td>
<td>Large residuals make position unreliable</td>
</tr>
<tr>
<td>14-17 Reserved</td>
<td>For SPAN-capable receivers</td>
</tr>
<tr>
<td>18 PENDING</td>
<td>When a FIX POSITION command is entered, the receiver computes its own position and determines if the fixed position is valid a</td>
</tr>
<tr>
<td>19 INVALID_FIX</td>
<td>The fixed position, entered using the FIX POSITION command, is not valid</td>
</tr>
<tr>
<td>20 UNAUTHORIZED</td>
<td>Position type is unauthorized - HP or XP on a receiver not authorized for it</td>
</tr>
</tbody>
</table>

---

a. PENDING implies there are not enough satellites being tracked to verify if the FIX POSITION entered into the receiver is valid. The receiver needs to be tracking two or more GPS satellites to perform this check. Under normal conditions you should only see PENDING for a few seconds on power up before the GPS receiver has locked onto its first few satellites. If your antenna is obstructed (or not plugged in) and you have entered a FIX POSITION command, then you may see PENDING indefinitely.
C.2.2 **TILT Compensation**

Tilt Compensation affects existing logs as follows:

- NovAtel logs that provide the Extended Solution Status field (BESTPOS and BESTXYZ, both documented in *OEMV Family Firmware Reference Manual*) use the 0x80 bit to flag the fact that Tilt Compensation is being applied.

- For NMEA GPGGA, GPGGARTK, and GPGGALONG logs, the precision of various fields indicates whether the Tilt Compensation is being applied.

C.2.3 **VERSION   HW & SW Versions and Serial Numbers**

The Component Type of the VERSION log, refer to the *OEMV Family Firmware Reference Manual*, is extended to include SMART-AG information as in **Table 19**.

**Table 19: Component Type**

<table>
<thead>
<tr>
<th>Binary Value</th>
<th>ASCII Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>UNKNOWN</td>
<td>Unknown Component</td>
</tr>
<tr>
<td>1</td>
<td>GPSCARD</td>
<td>OEMV GPSCard Component</td>
</tr>
<tr>
<td>3</td>
<td>ENCLOSURE</td>
<td>SMART-AG Receiver</td>
</tr>
<tr>
<td>8</td>
<td>USERINFO</td>
<td>User-application information component</td>
</tr>
<tr>
<td>981073925</td>
<td>DB_USERAPPAUTO</td>
<td>Auto-starting user-application firmware</td>
</tr>
<tr>
<td>(0x3A7A0005)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* a. Unused numbers are reserved for future use.

For the SMART-AG, the BT MAC address field has been added, in hexadecimal format, to the USERINFO block, “002166000001” in the following example.

```
[COM1]<VERSION COM1 0 94.5 UNKNOWN 0 156.357 004c0001 3681 5010
  < 3
  <    GPSCARD "N1GA" "DHC09401037" "MCAGTP-1.00-22B" "3.710" "3.002"
    "2009/Nov/30" "11:08:19"
  <    DB_USERAPPAUTO "SmartAg" "0" "1.100" "2009/Nov/27" "13:22:29"
  <    USERINFO "LMX9830" "0212" "002166000001" "002166000000" "1.100"
[COM1]
```

In the above example, the firmware is shown as 3.710 and the SMART-AG application is shown as 1.100.
The following are a list of the replacement parts available for your NovAtel SMART-AG receiver. Should you require assistance, or need to order additional components, please contact your local NovAtel dealer or Customer Service representative.

## D.1 SMART-AG

<table>
<thead>
<tr>
<th>Part Description</th>
<th>NovAtel Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART-AG</td>
<td>01018203</td>
</tr>
<tr>
<td>Cable: 14-pin socket to 2 DB-9 connectors, twisted CAN I/O pair, and other bare wire connectors (see Section 25, SMART-AG Development Kit Cable starting on Page 60)</td>
<td>01018256</td>
</tr>
<tr>
<td>Mounting Plate</td>
<td>70023072</td>
</tr>
</tbody>
</table>

## D.2 Accessories

<table>
<thead>
<tr>
<th>Part Description</th>
<th>NovAtel Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>OEMV Family Compact Disc with PC utilities including <strong>CDU</strong></td>
<td>01018235</td>
</tr>
<tr>
<td>OEMV Family Installation and Operation User Manual</td>
<td>OM-20000093</td>
</tr>
<tr>
<td>OEMV Family Firmware Reference Manual</td>
<td>OM-20000094</td>
</tr>
</tbody>
</table>

[The accessories above are also available from www.novatel.com]
Index

$PMDT command, 77

A
accuracy
  position, 31, 59
  velocity, 59
almanac, 70
antenna
  internal, 18
  mounting, 23
  single-frequency, 23
  specifications, 60
ascii, 45
AUTH command, 48
authorization, 49
AUX port, 76
  identifier, 68

B
base station, 35
baseline, 31
baud rate, 28
baud rate, see bps
BESTPOS log, 81
BESTXYZ log, 81
bidirectional communication, 29
bit rate, see bps
Bluetooth, 22
  configuration, 54–58
bps, 69
break, 67, 69
buffer, 28, 72

C
cable
  serial, 28
  warranty, 12
CAN. See Controller Area Network
Caution, 28
CDU software, 39, 73, 87
CMR, 34
cold start, 59
COM command, 67
COM port, 73
command, 66
  CDU, 30
  communication, 28
  error message, 31
  example, 31
  in CDU, 43, 48
  interface, 34
  multiple, 35
  note, 30
  port, 28
  pre-configure, 33
  prompt, 30
  RTK, 35
communication
  bidirectional, 29
  Bluetooth, 54
  CDU, 30
  getting started, 29
  notice, 13
  operation, 28
  PC/laptop, 29
  physical, 20
  port, 23, 28
  remote terminal, 29
COMVOUT command, 67
configuration
  additional equipment, 20
  base station, 33
  Bluetooth, 54–58
  CDU, 30
  model, 19
  port, 28, 67
  rover station, 34
  RTK, 35
  typical hardware, 28
configuring, 37
connector
  input/output, 60
  mounting bracket, 23
  specifications, 60
Controller Area Network, 25
Convert software, 45
copyright, 2
CPU, 72
Customer Service, 15, 48

D

data
  Bluetooth, 54
  collect, 24
  erase, 70
  format, 66
  L-band, 70
  link, 32
  log, 72–73
  NVM, 70
  port, 23, 28
  start, 29–30
  storage device, 32
  terminal, 29
  Warning, 31
DC power, 60
dealer, 15, 48
default
  Bluetooth, 56
  factory, 70
  interface mode, 34
  log, 73
  offset, 74
  period, 74
  port, 28, 72–74
  reset, 70
  trigger, 74
differential
  configuration note, 35
  corrections, 31, 62
  operation, 31
  serial cable, 62
  setup, 32
directional communication, 29
distance exceeded, 85

E
echo, 69
EGNOS, 35
e-mail, 15
Emulated Radar (ER), 25, 78, 82

operation, 36
enable Bluetooth, 54
ESTB, 35

F
factory default
  setting, 67
features, 19, 29, 48–49
firmware upgrades, 48–49
FRESET command, 70

G
GL1DE, 36
GLONASS, 46
GPGGA log, 80
GPS Antenna, 12
GPVTG log, 80
graphical user interface, 40

H
handshaking, 28, 68–69
hardware
  Bluetooth, 54
  connector, 20
  enclosure, 18
  replace, 87
  required, 20
  setup, 22, 32
  specifications, 61
header, 17
height limit, 85
hexadecimal, 17
hibernate mode, PC, 73
hold, 72, 74

I
identifier, serial port, 75
idle time, 28
input
  command, 30–31
  connector, 60
differential, 33–34
  mark, 74
  power, 22
  syntax, 66
install, 16
installation, 39
integration, 16
interface
  base or rover, 33–34
  Bluetooth, 54
  communication, 29
  graphical, 22
  serial, 28
introduction, 18

L
laptop power settings, 73
LED
  front, 18
  power, 21, 24
light emitting diode (LED), see LED
log, 34, 72–73, 82
LOG command, 72
logs
  tilt compensation, 86
logs in CDU, 44

M
memory, 72
message trigger, 74
model, 19

N
NMEA logs, 80
note, logging, 72
Notices, 13
NovAtel Inc., 2, 15
NovAtel position logs, 81

O
operation, 28
optionality, 17
output
  connector, 60
  convention, 17
  log, 72–74
  status, 29–30
  syntax, 66
  overload, 72

P
parity, 28, 68–69
PC power settings, 73
period, 72, 74
port
  Bluetooth, 56
  COM, 20, 28, 30, 34
  configuration, 67, 69
  identifier, 68, 75–76
  interface mode, 33–34
  log, 72–74
  output, 74
  prompt, 30–31
  serial, 28
  settings, 28
position
  accuracy, 31
  base, 31, 33
  best, 82
  command, 31, 35
position logs, 81
power, 21–22
pseudorange, 35

R
RADARCFG command, 77
RADARSIGNAL log, 82
receiver outputs, 80
receiver status, 72
replacement parts, 87
reset
  FRESET command, 30, 70
    option, 70
    target, 70
RESET command, 77
revision, firmware, 1, 48
Rinex, 45
rover station, 35
RTCA, 34
RTCM, 33–34
RTCMV3, 33–34

S
satellite, 23, 28
self-test, 29, 72
serial
Index

cable, 28
number, 48
port, 34, 75
standby mode, PC, 73
status, receiver, 72
support, 12, 15
syntax, 66

T

technical specifications, 59
terrain compensation. See tilt compensation
tilt compensation, 26, 37
   $PMDT command, 77
logs, 86
operation, 37
time, 72, 74
transmit, 69
trigger, log, 72–73

U

upgrade firmware, 15, 48–49
USB port, 68

V

velocity limit, 85
version, 49

W

Warning
   CE, 14
   FCC, 13
   voltage, 22
warranty, 12
website, 15
windows in CDU, 40–44
WinLoad, 49
WRITE command/log, 86